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RAPID Disclaimer

The development of the RAPID software program was funded by the Federal Aviation
Administration (FAA) and the USAF and is provided to the user as is. Neither the FAA nor the
U.S. Government warrants the merchantability of the software nor its fitness for a particular use.
Use of RAPID or its output does not replace or change any part of the repair or alteration
approval process. Users of RAPID must obtain approval of any repair or alteration designed or
analyzed with RAPID with the same procedures as with any other analysis tool. A repair design
from RAPID should never supersede that supplied by the original equipment manufacturer
(OEM). RAPID should be considered an alternative design tool whenever a repair procedure is
not provided or is not available from the OEM. In no instance will the U.S. Government be liable
for any damages sustained by the user, or any third party, caused by or attributed to the use of the
RAPID software.
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1.  Introduction

This document provides installation and usage instructions for the Repair Assessment Procedure
and Integrated Design (RAPID) program.  It should be read by any user who is not already
familiar with running the current version of RAPID.  In the companion document, Repair
Assessment Procedure and Integrated Design RAPID Version 2.1, Analysis Methodology
Document, technical details of the analysis methodology used in the program are provided.

RAPID is a tool for the design and analysis of aircraft structural repairs.  This version assists the
user in designing mechanically fastened fuselage skin repairs with up to three doublers.  RAPID
performs both static and damage tolerance analyses of the repair.  The static analysis determines
if the doublers and fasteners are statically adequate, while the damage tolerance analysis yields
inspection intervals and residual strength.
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2.  Requirements

The following are the minimum hardware and software requirements for installing and running
the RAPID software:

• 386 PC (a 486 or better is highly recommended).

• Math coprocessor if the CPU is a 386 or 486sx.  (The coprocessor reduces run
times for damage tolerance analysis from hours to minutes.)

• Windows 3.1 running in enhanced mode.  Although RAPID is a Windows 3.1
program, it has been tested within and runs under Windows 95 and Windows NT
v4.0.

• Hard disk with 25 megabytes free disk space.  The load spectra, if generated,
require an additional 5 to 25 megabytes each.

• 4 megabytes random access memory (RAM) (8 megabytes or more is preferred).
Windows 95 and NT require additional memory.

• 3.5 inch 1.44MB floppy disk drive.

• VGA (Super VGA, 800 by 600 dpi resolution or higher is recommended).

• Mouse or track-ball recommended.
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3.  RAPID Program Notes and Limitations

This section lists graphical user interface notes and program limitations for the current version of
RAPID.  Updated versions of this information will be available in RAPID from the Readme
Infor mation menu item in the Help pull-down menu.

3.1  RAPID Graphical Use r Interface Notes

3.1.1  Help K eys and Buttons

The F1 key will bring up HELP in any module.  The help will be module specific.  However,
once in HELP, other areas of HELP can be accessed.  Each module has a HELP button that acts
like the F1 key.

3.1.2  Checking Cutout Pro perties

Checking the cutout information through the menu or cutout button after the cutout is drawn
does not work.  As a work around, the cutout information may be accessed by selecting the
cutout with the mouse and then clicking with the right mouse button on the cutout.  This problem
is scheduled to be corrected in a later version of RAPID.

3.1.3  Cutout Displ ay Problem

If the cutout is initially drawn after the display has been scrolled horizontally or vertically, the
cutout will be displayed in the wrong location, although the geometry is stored correctly.
Resetting the zoom to 100% will display the cutout correctly.  This problem is scheduled to be
corrected in a later version of RAPID.

3.1.4  Conflict with PC-Xwa re

RAPID will not run when PC-Xware is installed in Windows.

3.2  Analysis General Notes and Program Limitations

The RAPID version 2.1 program performs static strength and damage tolerance analysis of a
repaired fuselage skin which involves a damage treatment of the skin cutout and replacement of
the removed skin with repair doublers.  The repair doublers are mechanically fastened to the
skin.  The following addresses the analysis capability of the current version of the program.

3.2.1  General

a. Repairs are restricted to fuselage skin repairs between forward and aft pressure
bulkheads, but away from door cutouts, window cutouts, and window belt structure.
This is also not applicable to pressure bulkheads or flat pressure panels.

b. The fuselage is assumed to be circular with a constant radius. The repairs are limited
to areas on the airplane where the hoop stress due to pressurization can be
approximated using a cylindrical pressure vessel analysis.
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c. Damage due to accidental or cracking causes is only in one skin layer except the lap
joint repairs which both upper and lower skins may be

d. Skin cutout and repair doublers are rectangular or circular in shape. For rectangular
repairs, the orientation is such that two of the four sides are in the hoop stress
direction and the other two are in the longitudinal stress direction.

e. Nine repair configurations are included as depicted in the following figure:

1) One Internal,
One External

2) Two Doublers,
Internal or
External

3) One Doubler,
Internal or
External

6) Single, Flushed
Lap Joint

5) Sandwiched
Butt Joint

7) Single, T-Shaped
Lap Joint

8) Double
Lap Joint

9) Circular
External

4) Single, 
Circumferential

Butt Joint

4) Single,
Forward-Aft
Butt Joint

f. For Type 1 repairs, only one outstanding fastener row (beyond the external doubler)
is allowed in the internal doubler.

External
Doubler

Skin Cutout

Internal
Doubler

External Doubler

Skin Cutout
Internal Doubler

Skin

Outermost
Fastener Row

Skin Cutout

Outermost
Fastener Row

Outermost
Fastener Row

Outermost
Fastener Row
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g. For Type 2 repairs, only one outstanding fastener row (beyond the external doubler
number 1) is allowed in the external doubler next to the skin.

External
Doubler 1

External
Doubler 2

External Doubler 2

External
Doubler 1

Skin

Skin Cutout

Skin Cutout Outermost
Fastener Row

Outermost
Fastener Row

Skin Cutout

Outermost
Fastener Row

Outermost
Fastener Row

h. The program is capable of assessing common repairs such as a repair near another
repair, repairs near stiffeners, and repairs at joints.

i. The following restrictions are applied to the RAPID 2.1

• For a repair near another repair:

Only Type 1, 2, and 3 repairs are considered.

• For repairs at/near stiffeners:

Only Type 1, 2, and 3 repairs and repairs over splice joints are considered.

• For a repair at/near stiffeners near another repair:

Only Type 1, 2, and 3 repairs are considered.

j. Repairs are limited to the following sizes

• Skin cutout size  (Add 3 ~ 5 fastener rows to determine the repair size)

- Type 1,2,3 repairs: 30″ (Long.) x 20″ (Circumferential)
- Circular repairs: 5″ (Radius)
- Butt joint repairs: 20″ (Long.) x 10″ (Circumferential)
- Lap joint repairs: 20″ (Long.) x 5″ (Circumferential)

• Skin cutout size in proximate repairs
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- Subject repair: 30″ (Long.) x 20″ (Circumferential)
- Proximate  repair: 25″ (Long.) x 25″ (Circumferential)

k. The static strength and damage tolerance analyses are limited to material and fastener
databases available in RAPID.

3.2.2  Static Strength Analysis

a. Static strength analysis is performed using the fastener joint allowable, the repair
doubler allowable, and the shear allowable of skin and doubler. The margins of safety
are calculated and flagged to testify adequacy of the repair. The stiffness ratios
between the repair doublers and skin layers are checked and flagged to indicate
whether the repair is too stiff or not stiff enough.  Fastener bending and inter-rivet
buckling guidelines are provided in the Advisory System.

b. The load carrying capacity lost due to skin cutout is calculated using the design
ultimate tensile strength and cutout size of the skin.

c. The database of fastener joint allowables is built using the data in the MIL-HDBK-
5F. [1]

3.2.3  Damage Tolerance Analysis

a. In a repaired skin, the load transfer at the corner fastener tends to be higher than that
at the center fastener.  Load transfers along the critical fastener row are obtained
using the two-dimensional analysis of the repaired skin with the fastener shear
stiffness calculated using the Swift’s equation [2]. It is noted that the fastener loads
are calculated for the un-cracked repaired skin configuration; and the load transfer in
each fastener remains constant in the damage tolerance analysis.

b. Damage tolerance analysis is performed for both longitudinal and circumferential
through cracks emanating from the critical fastener holes in the fastener row along all
four sides of rectangular repairs, as shown in the following figure.

Skin Cutout

Side 2 Critical Fasteners

Side 3 
Critical 
Fasteners

Side 1 
Critical 
Fasteners

Side 4 Critical Fasteners
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c. The crack geometry is assumed to be through crack. Following are cases of initial
crack assumptions made in the analysis

(1) Type 1, 2, and 3 repairs:

• A through crack emanating from the center fastener hole

• Two asymmetric through cracks emanating from the center fastener hole

• A through crack emanating from the corner fastener hole

(2) Circular repairs:

• A through crack emanating from the outermost fastener hole in the applied
stress direction

(3) Lap joint repairs:

For the upper skin:

• When stress is parallel to the splice direction, a through crack emanating
from the critical fastener hole next to the free edge of the skin in the
outermost fastener row

• When stress is normal to the splice direction, crack configurations
assumed above for Type 1, 2, and 3 apply.

For the lower skin:

• When stress is parallel to the splice direction, a through crack emanating
from the critical fastener hole next to the edge of the overlapped splice in
the outermost fastener row

• When stress is normal to the splice direction, crack configurations
assumed above for Type 1, 2, and 3 apply.

(4) Butt joint repairs:

• When stress is parallel to the splice direction, a through crack emanating
from the critical fastener hole next to the free edge of the skin in the
outermost fastener row

• When stress is normal to the splice direction, crack configurations
assumed above for Type 1, 2, and 3 apply.

d. The default initial crack sizes are primary crack 0.05″ and secondary crack 0.005″ for
all cases in the program.  The user, however, can directly input other initial crack
sizes for the analysis.

e. Crack sequences are assumed as follows:
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(1) For Type 1, 2, and 3 repairs:

• For a through crack emanating from the center fastener hole, the crack
grows towards the adjacent hole.  When the crack tip grows into the
adjacent hole, two through cracks of size equal to 0.005″ are assumed to
exist instantaneously, one at each outer side of the holes.

• For two asymmetric through cracks emanating from the center fastener
hole, the cracks grow towards the adjacent holes.  When a crack tip
grows into the hole, a through crack of size equal to 0.005″ is assumed
to exist instantaneously at the opposite side of the hole.

• For a through crack emanating from the corner fastener hole, the initial
crack grows towards the adjacent hole.  When the crack tip grows into
the adjacent hole, two through cracks of size equal to 0.005″ are
assumed to exist instantaneously, one at each outer side of the holes.  In
such a case, one crack tip continues to grow towards the adjacent hole;
while the other crack tip grows in the skin without entering any holes.

(2) For circular repairs:

• The crack grows in the skin without entering any holes

(3) For lap joint repairs:

For upper skin:

• When stress is parallel to the splice direction, the crack grows towards
the free edge. When the crack tip reaches the edge, a through crack of
size equal to 0.005″ is assumed to exist instantaneously at the opposite
side of the hole. The crack continues to grow towards the adjacent
hole.

• When stress is normal to the splice direction, crack growth scenarios
assumed above for Type 1, 2, and 3 apply.

For lower skin:

• When stress is parallel to the splice direction, the crack grows towards
the adjacent hole. When the crack tip enters the hole, two through
cracks of size equal to 0.005″ are assumed to exist instantaneously,
one at each outer side of the holes.

• When stress is normal to the splice direction, crack growth scenarios
assumed above for Type 1, 2, and 3 apply.
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(4) For butt joint repairs:

• When stress is parallel to the splice direction, the crack grows towards
the free edge. When the crack tip reaches the edge, a through crack of
size equal to 0.005″ is assumed to exist instantaneously at the opposite
side of the hole.  The crack continues to grow towards the adjacent
hole.

• When stress is normal to the splice direction, crack growth scenarios
assumed above for Type 1, 2, and 3 apply.

f. Two types of stress-intensity factor solutions are implemented in RAPID:

(1) Basic solutions:

• A through crack emanating from a hole in a wide plate
• Two asymmetric through cracks emanating from a hole in a wide plate
• A through crack approaching a hole in a wide plate
• An edge crack in a semi-wide plate
• A through crack growing towards a stiffener in a wide plate
• A through crack at stiffener growing towards adjacent stiffeners in a

wide plate
• A through crack between two stiffeners growing towards adjacent

stiffeners in a wide plate

(2) Derived solutions:

• A through crack passing through two or more holes
• An edge crack passing through one or more holes

Solutions for both uniform far field stress and pin loads are considered. The
interference-fit and neat-fit-pin effects are ignored.

g. Residual strength of the skin is assessed based on the fracture toughness approach.

h. Crack growth analysis can be performed using either the simplified method, or the
cycle-by-cycle method with or without the retardation effect in the analysis.  When
the retardation effect is considered, it is accounted for by using the generalized
Willenborg retardation model.

i. Crack growth prediction using the simplified method, is based on Walker’s crack
growth equation [3].  Coefficients in the Walker’s equation are reduced for the
following 13 materials:

• 2024-T3 Clad Sheet, -T42 Bare Sheet, L-T RT LA DW
• 2024-T3 Clad Sheet, -T42 Bare Sheet, T-L RT LA DW
• 2024-T3 51 Plate, -T3511 Extrusion, L-T RT LA DW
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• 7050-T7452 Forging, L-T T-L  LA RT
• 7050-T74511, -T76511 Extrusion, L-T RT LA DW
• 7050-T74511, Extrusion, L-T RT STW
• 7050-T7651, -T7451 Plate, L-T T-L RT LA DW
• 7050-T76511, Extrusion, L-T RT STW
• 7475-T7351, Plate, L-T LA RT
• 7475-T7651, Plate, L-T LA RT DW
• 7475-T761, Clad Sheet, L-T RT LA DW
• 7075-T6, Clad Sheet, L-T RT LA
• 2014-T6 Sheet, T = 0.05, L-T RT LA 10Hz

In the cycle-by-cycle method, table lookup of the da/dN rate data is used in the
analysis.

j. Generic load spectra for narrow- and wide-body aircraft are generated at the fuselage
c.g. location.  RAPID converts the load spectrum into the stress spectrum near the
repair location for the crack growth analysis.  The user can also provide RAPID with
the stress spectrum for analysis.

k. Limit stress in the circumferential direction is

t

R1.1

t

pR1.1c
lim +=σ

Where p is the operating pressure differential in psi, R is the fuselage radius, and t is
the thickness of the fuselage skin.  The second term represents an upper bound on
aerodynamic pressure.

The limit stress in the longitudinal direction is

5.1

FC tu1l
lim =σ

where Ftu is the ultimate tensile strength of the material and C1  is the strength
reduction factor obtained from manufacturer’s testing data.  In RAPID, C1 takes a
value of 0.88 for 2024-T3 alloy materials.

l. The inspection threshold is established using the following formula:

2

N
N Critical

Threshold =

where NCritical is the number of flights associated with the critical condition.
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m. The inspection interval is determined using the following formula:

NInterval = 
2

NN DetectableCritical −

where NCritical is the number of flights associated with the critical condition, and
NDetectable is the number of flights associated with the detectable crack length for an
NDI method.

n. The detectable crack length is defined as follows:

• No Hole-to-Hole crack:

aDet.

C

• Hole-to-Hole crack:

aDet.

Hole-to-Hole Crack C

Details of the analysis methods are provided in the companion Analysis Methods
Document.
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4.  Document Conventions

This manual uses the following special fonts:

ALL CAPS This type represents file categories or names and disk directories

Bold This type represents application commands, menu items, edit fields, etc.

Italic This type represents string(s) that are found in a file

Monospace  This type represents text that user types or text as it appears on the
screen.
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5.  RAPID Support Ser vices

5.1  Telephone Support

For technical assistance, problem reporting, or general questions regarding RAPID, please
contact:

John Bakuckas
AAR-431
FAA William J. Hughes Technical Center
Atlantic City International Airport, NJ 08405
Phone: (609) 485-4784
FAX: (609) 485-4569
e-mail: John_Bakuckas_at_ct27@admin.tc.faa.gov

or

Michael Shiao
AAR-431
FAA William J. Hughes Technical Center
Atlantic City International Airport, NJ 08405
Phone: (609) 485-4137
FAX: (609) 485-4569
e-mail: Michael_Shiao_at_ct27@admin.tc.faa.gov

Any problems or difficulties encountered while running RAPID should be reported.  If you
discover any problems with RAPID, fill out the RAPID Problem Description Form supplied in
the subsequent section documenting the events that led up to the problem in RAPID and the
manifestations of the problem.  This form should be submitted as soon as the problem is
discovered.  The same information may be supplied using e-mail if the user so desires.
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5.2  RAPID Problem Desc ription Form

Name:                                                                                      Phone:                                     

Company:                                                                                FAX:                                       

Address:                                                                                  e-mail:                                     

City, State & Zip Code:                                                                                                                      

Problem Description:

                                                                                                                                                            
                                                                                                                                                            
                                                                                                                                                            
                                                                                                                                                            
                                                                                                                                                            
                                                                                                                                                            
                                                                                                                                                            
                                                                                                                                                            
                                                                                                                                                            
                                                                                                                                                            

FAA Use Only

Date Received:                     Date Validated:                         Date of Response:                        
Problem Source (Circle One)

Application
Documentation
Hardware
System Software
Other:                                                                                                                                                  

Module Affected:                                Date Fixed/Incorporated:                                                  

Final Disposition:
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6.  Installation

The following instructions are for Windows 3.1, Windows 95 and Windows NT 4.0.

6.1  Run Setup

Exit all other Windows programs, insert Disk 1, and then run the setup  program.  Setup can be
run by double-clicking the icon or by entering the following command at a DOS prompt or in a
“Run…” dialog.

a:\setup

If a previous version of RAPID is already installed, then user created models and data files
should first be backed up, and then the previous version of RAPID should be uninstalled or
removed.  Older versions of RAPID which do not include an uninstall utility can be removed by
simply deleting the RAPID directory and its contents.  Please note that repair configuration data
files generated by older versions of RAPID may not be compatible with the current version.

After a few moments, the following dialog will appear.  Select the Next button to continue.
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6.2  Choose Destination Location

To install RAPID in the default C:\RAPID\  directory, select the Next button.  To install
elsewhere, select the Browse button and enter an alternate directory location.

When installing from disk, a dialog will appear which will prompt the insertion of the next disk.
Simply remove the current disk, insert the requested disk, and press the Enter key on the
keyboard.

The extraction process will install the following files:

PROGRAM FILES:

RAPIDMDI.EXE The RAPID MDI Windows executable program
STATIC.PIF  The STATIC Program Information File
DADTA.PIF  The DADTA Program Information File
GENRLN.PIF The GENRLN Program Information File
GENRLW.PIF The GENRLW Program Information File
EQVSTRS.PIF The EQVSTRS Program Information File
GENRSPEC.PIF The GENRSPEC Program Information File
USRSSPEC.PIF The USRSSPEC Program Information File
SSPECCHK.PIF The SSPECCHK Program Information File
CHKDADN.PIF The CHKDADN Program Information File
REPAIRD.EXE The RAPID-callable version of the Damage Tolerance Analysis

Program
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REPAIRS.EXE The RAPID-callable version of the Static Analysis Program
CTL3DV2.DLL  The Microsoft 3-D Controls Dynamic Link Library
BIVBX30.DLL  Allows 16 bit programs compiled in Win95 to run under Win3.1
BWCC.DLL The Borland Windows Custom Controls Dynamic Link Library
GENRLN.EXE The Generic Narrow Body Load Spectrum Generation Program
GENRLW.EXE The Generic Wide Body Load Spectrum Generation Program
USRSSPEC.EXE The User Input Stress Spectrum Generation Program
GENRSPEC.EXE The Generic Stress Spectrum Generation Program
EQVSTRS.EXE The Equivalent Stress Generation Program
SSPECCHK.EXE The Stress Spectrum Format Check Program
CHKDADN.EXE The da/dN Format Check Program
USRSSPEC.DAT User Stress Spectrum Generation Input File Example
CHKDADN.INP da/dN Input Format Check Program
README.WRI Documents last minute changes and corrections
ANALYSIS.WRI Boilerplate text included in RAPID Repair Reports
TEMPLATE.1 Stress Report Template
DISCLAIM.DOC RAPID Disclaimer

ADVISORY SYSTEMS FILES:

RAPID.HLP The RAPID Help system file
ADVISE.DAT The RAPID Advisory system data

DATABASE FILES:

MATERIAL.DAT Material database
MATTHICK.DAT Material database thickness parameters
MATPROP.DAT Material properties database
MAT-FT.DAT Fracture Toughness Database
FTYPE.DAT Fastener database (1 of 2)
RIVET.DAT  Fastener database (2 of 2)
TEMPER.DAT Material Temper Database
SURFACE.DAT Material Surface Database
FORM.DAT Material Form Database
REPAIRD.FST Fastener Factors database
REPAIRD.JNT Splice Joint database
REPAIRD.LCF Life Correction Factor database
REPAIRD.STB Stiffener database
REPAIRD.STF Stiffener Ratio Factors database
REPAIRD.MAT da/dN database
REPAIRD.SIF  Stress-Intensity Factors database
REPAIRD.PRX Proximity database
RPRTYPE.DAT Repair Configuration database
REPAIRD.CIR  Damage Tolerance Circular Repair Ratio Factors
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EXAMPLE FILES:

TYPE1.RPD Type 1 repair example problem
TYPE2.RPD Type 2 repair example problem
TYPE3.RPD Type 3 repair example problem
TYPE41.RPD Type 4 longitudinal butt joint repair example problem
TYPE42.RPD Type 4 circumferential butt joint repair example problem
TYPE5.RPD Type 5 repair example problem
TYPE6.RPD Type 6 repair example problem
TYPE7.RPD Type 7 repair example problem
TYPE8.RPD Type 8 repair example problem
TYPE9.RPD Type 9 repair example problem
PSEUDO.SSF Sample User Defined Pseudo-Flights Stress Spectrum
CYCLE.SSF Sample User Defined Cycle-by-Cycle Stress Spectrum

If you are replacing version 1.x of RAPID, then you will no longer need the dosxnt.386
device driver (unless it is required by programs other than RAPID).  Edit the system.ini  fi le
in the windows  directory.  On some systems, this file might be located in the
windows\system  directory.  Search for the string dosxnt.386.  If the string is found and it
includes reference to the RAPID directory (indicating that it was installed solely for RAPID),
then delete that line from SYSTEM.INI:

device=c:\rapid\dosxnt.386

6.3  Complete the Installa tion

The following dialog will appear which asks if you would like to view the README file.  You
may select No to skip, since the README file can be viewed within the RAPID program.  If
Yes is selected, then the README file will be displayed.

The following dialog will appear to verify that the installation of RAPID is complete.  Click the
OK  button to exit the installation procedure.  Remove the remaining disk from the floppy drive
and store the disks in a safe location.
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The RAPID program may then be run by double-clicking on the installed RAPID ver 2.1
program icon.  In Windows 95 and Windows NT 4.0, RAPID may also be run by selecting it
from within the Programs section of the Windows Start button.

6.4  Change to Super VG A mode (recommended)

Although it is possible to use RAPID with any Windows-compatible display, it is recommended
that a minimum window resolution of 800 by 600 dots per inch (Super VGA) be used so that the
windows will fit the display without the use of scrolling.  Most computers will support the Super
VGA driver which is shipped with Windows 3.1.  To change to Super VGA mode, open
WINDOWS SETUP (in the MAIN program group) and select Change System Settings from the
Options menu, and then select Super VGA (800x600, 16 colors) in the Display field and press
the OK  button.  (Note which video mode you were using in case you need to switch back later).
If prompted to use the currently installed driver, select Current .  Otherwise, you will need to use
your original Windows 3.1 installation disks when prompted.  Finally, when prompted, restart
Windows to switch to the new display driver.  If, after changing the video mode, you are unable
to restart Windows, you will need to return to your original video mode.  The video mode can be
reset by running the Windows Setup program from DOS, changing to the WINDOWS directory,
and running SETUP.

For Windows 95 and Windows NT 4.0, please refer to the hardware and operating system
documentation included with the computer.  Typically, the video mode can be changed through
the Settings tab on the Display Properties, accessible from both the Control Panel, or by
clicking the right mouse button on the Windows desktop and then selecting Properties.
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7.  Running RAPID

RAPID is run by double-clicking on the installed RAPID ver 2.1 program icon.  In Windows 95
and Windows NT 4.0, RAPID may also be run by selecting it from within the Programs section
of the Windows Start button.  When opened, RAPID fills the screen with the RAPID Multi-
Document Interface (MDI).  Commonly used tools and options are available both from the icon
button bar and from the pull-down menus.  Other options are available only from the pull-down
menus.  As with most Windows applications, the pull-down menus can be accessed both by
mouse selection and by holding down the “Alt” key then pressing the key-character of the menu
item.  (The key-character is underlined.) For use with a mouse, however, selection is simplified
by the icon button bar.  Each button represents a selection available in a pull-down menu.  As the
mouse pointer is placed over any of the buttons, a description of the button is displayed in the
strip along the bottom of the RAPID MDI window.

The following figure shows an example of the RAPID MDI with several of the input windows
opened.

Selections can be made in any order, except for those which require prior input.  For example,
the Analysis menu items are not available for selection (and are grayed-out) until all of the data
necessary for the model has been input.
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Before RAPID can be used to edit oout a repair model, an existing model must be opened or a
new model must be created.  This is done by selecting the New or Open menu items from the
File menu or by selecting the corresponding icon buttons.  These buttons are the two buttons
furthest to the left on the button bar.

For a typical text-based input, the icon buttons would be selected from left to right, beginning
with the Aircraft/General Information  dialog and culminating with the Report dialog.  If an
icon button or a menu item is grayed-out, then either the prerequisite information has not yet
been entered or that option is not pertinent to the current model.

In describing the use and function of the dialog windows, it is necessary to first define several of
the features common to all dialog windows, as shown below in the fictional GUI Tools dialog
window.  As depicted, an Edit Field  is used to enter alphabetic or numeric data.  A Combo Box
is also used to enter alpha-numeric data with the added option of selecting predefined entries
from an attached list, which may be scanned using its scroll bar.  Radiobuttons are used to
select among a group of mutually exclusive input options.  CheckBoxes are used to toggle
independently selectable options.  Finally, Pushbuttons (here represented by the Save button,
and sometimes referred to simply as buttons) are used to invoke an action.
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7.1  Opening Wind ow

The opening window displays the RAPID Multidocument Interface.  All other windows in the
RAPID system are selected from and displayed in this window.  The gray strip along the bottom
describes the function of each button as it is pointed to by the mouse.

The icon buttons near the top of the window activate most of the capabilities within RAPID.  In
every case, their functions are reproduced by selections within the pull-down menus located on
the line above the button bar.  The icon buttons perform the functions listed below.  The bold
face entries are documented within this section.

 Starts a New repair.

 Opens an existing repair file.

 Saves the current repair to a file.
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 Prints the current window.

 Invokes the Aircraft/General Information  dialog window.

 Invokes the Repair Type dialog window.

 Invokes the Damage Location Information dialog window.

 Switches mouse to Repair Boundary drawing mode.  This tool is used to draw the
rectangular repair boundary, as defined by the two frames and two longerons which enclose the
area of the repair.  The repair boundary is drawn by clicking the left mouse button on one corner
of the desired location of the repair boundary and then, while continuing to depress the left
mouse button, dragging the mouse to the opposite corner of the repair boundary, at which point
the left mouse button is released.

 The frame tool is used to draw frames that are overlapped by the repair.

 The longeron tool is used to draw longerons that are overlapped by the repair.

 Invokes the Skin Properties dialog window.

 Switches mouse to Skin Cutout drawing mode.  The cutout tool is used to draw the
rectangular cutout.  The cutout is drawn by clicking the left mouse button on one corner of the
desired cutout, and then, while continuing to depress the left mouse button, dragging the mouse
to the opposite corner of the cutout, at which point the left mouse button is released.

 Invokes the Fastener Arrangement dialog window, which then automatically generates
the fastener rows and columns.

 Switches mouse pointer to Text input mode.  The text tool is used to annotate the drawing.
After selecting this tool, text may be entered directly on the drawing at the location indicated by
the next click of the left mouse button.

 Switches mouse to Select Object mode.  The selection tool is used to select graphical
objects, such as doublers and fasteners, which are already on the screen.  Once selected, objects
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can be moved and resized, unless their position has been frozen due to the existence of
dependent objects.  For example, cutouts cannot be moved after the fasteners are defined, since
that would require that the fasteners be regenerated.

 Switches mouse to Selective Zoom mode.

 Switches mouse to Delete Object mode.  The eraser tool is used to delete graphical
objects, such as the cutout and damage extent, which are already on the screen.

 Starts the Report module.

 Invokes the on-line Help system.

7.2  File Menu Listing

The File menu contains the typical Windows file utilities: New, Open, Close, Save, Save As,
Print, Print Preview, Printer Setup, and Exit .  New creates a new model.  Open reads a saved
repair model.  Close closes the current repair model file.  Save updates the file containing the
current repair model in a RAPID rpd  file.  Save As creates a new repair file with a name
supplied by the user.  Print sends the currently displayed analysis plot or view of the model to
the printer.  Print Preview displays a screen representation of the printed document. Printer
Setup invokes a standard Windows dialog for defining printer options.  Finally, Exit  closes the
currently opened models (after prompting the user to save changes) and quits RAPID.  Most of
these utilities can also be activated from the following icon buttons.

 Starts a new repair.
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 Opens an existing RAPID rpd  repair file

 Saves the current repair to a RAPID rpd  file.

 Prints the current window.

7.3  Edit Menu Listing

The Edit  menu contains Select Object, Copy, Paste, Delete Object, Delete All, and Multiple
Delete menu selections.  Select Object switches the mouse to selection mode so that objects may
be selected with the left mouse button.  Copy and Paste are not functional in the current release
but are included for completeness and will be used in future versions of RAPID to copy and
paste drawing objects and text, both within RAPID and to other applications such as drawing
programs and word processors.  Delete Object deletes the currently selected drawing object.
Delete All clears the drawing window.

Multiple Delete currently contains one option, to delete all Fasteners and Doublers.  If an
attempt is made to delete an object upon which other objects are dependent, then an
informational message will be displayed to the user.
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7.4  View Menu Listing

The View menu contains selections for modifying how the image of the model is displayed.  The
Show Fastener Legend selection, if checked, displays information on the screen about fasteners
used in the model. The Show Profiles selection toggles the display of cross sectional profiles.
The Show Dimensions and Show Reference Point selections similarly toggle display of the
model dimensions and coordinate system reference point. The Zoom selection invokes a dialog
which prompts the user to enter a desired magnification factor (sometimes called “Zoom Scale”).
Presets are provided in the dialog and on the tool bar for 50%, 100%, 200%, 400%, and 600%
magnification.

The Selective Zoom menu option provides a means to graphically indicate the desired
magnification by depressing the left mouse button while dragging the mouse diagonally across
the rectangular region to be magnified.  Selective Zoom can also be activated using the icon
button located on the button bar:
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7.5  General Menu Listing

The General menu contains Aircraft /General Information, Repair Type, and Damage
Location Infor mation selections.  Each is described in the following subsections.

7.5.1  Aircraft/General Infor matio n Screen     

This dialog is used to store the general information about the aircraft and the analyst.  Note the
OK , Cancel, and Help buttons.  The OK  button updates the current model with any information
entered in the window and then closes the window.  The Cancel button exits the dialog window
without saving any new entries.  Finally, the Help button retrieves help appropriate to this dialog
window.

Required data are indicated by an asterisk before the description of the entry, as shown above.
This includes the aircraft Model Number and the Serial Number.  The Model Number and
Serial Number are used strictly for bookkeeping purposes.
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7.5.2  Repair Type     

This window is used to select among the supported repair types.  For the repair type selected, a
generic schematic of the cross section is depicted within the window.  Currently, nine repair
types are available, as depicted in the following figure:

1) One Internal,
One External

2) Two Doublers,
Internal or
External

3) One Doubler,
Internal or
External

6) Single, Flushed
Lap Joint

5) Sandwiched
Butt Joint

7) Single, T-Shaped
Lap Joint

8) Double
Lap Joint

9) Circular
External

4) Single, 
Circumferential

Butt Joint

4) Single,
Forward-Aft
Butt Joint

Additional Radiobuttons or Checkboxes are provided to specify repairs over existing Lap and
Butt Splices, and repairs in Close proximity to another repair.  To include the effects of a



34

nearby repair, check the Close proximity to another repair box and then fill in the Proximity
Data dialog available in the Damage Tolerance section of the Analysis pull-down menu.

The OK  button updates the current model with any information entered in the window and then
closes the window.  The Cancel button exits the window without saving any new entries.
Finally, the Help button retrieves help appropriate to this window.

7.5.3  Damage Location     

This window is used to define the location of the damage on the aircraft in relation to several
pre-defined regions, which may be viewed by selecting the Zones button.  The entry fields are
defined in the figure below which is displayed on the screen by clicking on the Zones button.
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This input is used to determine the appropriate stress spectrum for the repair.  Repairs should be
restricted to fuselage skin repairs between the forward pressure bulkhead and front wing spar and
between the aft fuselage forward bulkhead and aft pressure bulkhead, Zones 1 and 4.  RAPID
should not be used when analyzing repairs in Zones 2 and 3 due to structural complexity of the
aircraft in those regions.  For repairs in these areas, the OEM should be consulted.

The OK  button updates the current model with any information entered in the window and then
closes the window.  The Cancel button exits the window without saving any new entries.
Finally, the Help button retrieves help appropriate to this window.

7.6  Design Menu Listing
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7.6.1  Repair Boundary Information     

The Repair Boundary Information  tool is used to draw the rectangular repair boundary, as
defined by the two frames and two longerons which enclose the area of the repair.  The repair
boundary is drawn by clicking the left mouse button on one corner of the desired location of the
repair boundary and then, while continuing to depress the left mouse button, dragging the mouse
to the opposite corner of the repair boundary, at which point the left mouse button is released.

The Repair Boundary Information  dialog window automatically appears after the repair
boundary is drawn.  The Top Longeron ID, Bottom Longeron ID, Left Frame F. S. and Right
Frame F. S. radio buttons refer to the longerons and frames which bound the area defined by the
repair.  In other words, those four frames and longerons must not cross over the cutout or the
doublers to be defined.  The Longitudinal direction  and Circumferential direction  edit fields
specify the distances between the right most and left most frames and the top and bottom
longerons, respectively.  If “Consider Stiffener Effects” is selected in the Repair Type dialog
window, then the cross-sectional and material properties of the frames and longerons should be
entered.

The stiffener properties are entered for each stiffener by clicking on the radio button for the
stiffener and then entering the properties in the Stiffener Properties section.
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The OK  button updates the current model with any information entered in the window and then
closes the window.  The Cancel button exits the window without saving any new entries.
Finally, the Help button retrieves help appropriate to this window.  Data entered in this dialog
window is displayed in the drawing window and is used to define coordinates of the cutout and
doublers but is not otherwise used in the analysis in this version of RAPID.

7.6.2  Overlapping Frames     

This window is used to define the number and position of the overlapping frames in the model.
The number of frames that the repair overlaps between the damage extent bounds (between the
right most and left most frames) is input in the Number of Overlapping Frames edit field.
RAPID will automatically determine the average spacing.  If stiffener effects are included in the
RAPID analysis, the cross-sectional and material properties of the stiffeners should be entered.
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7.6.3  Overlapping Longerons     

This window is used to define the number and position of the overlapping longerons in the
model.  The number of longerons that the repair overlaps between the damage extent bounds
(between the top and bottom longerons) is input in the Number of Overlapping edit field.
RAPID will automatically determine the average spacing.  If stiffener effects are included in the
RAPID analysis, the cross-sectional and material properties of the stiffeners should be entered.

7.6.4  Cutout Geometry     
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The Cutout Geometry tool is used to draw the rectangular cutout in relation to the top and
bottom longerons and the right most and left most frames defined in the Repair Boundary
dialog window.  The cutout is drawn by clicking the left mouse button on one corner of the
desired cutout and then, while continuing to depress the left mouse button, dragging the mouse to
the opposite corner of the cutout, at which point the left mouse button is released.

The Cutout Geometry dialog window is automatically invoked after the cutout is drawn with
the cutout tool and can be manually displayed by clicking with the right mouse button on the
cutout.

In the current version, only a single layer of skin may be cut out, except for the type 8 double lap
joint repair which has two overlapping cutouts in the skin lap joint.  The frames are assumed to
be perpendicular to the longerons, and the angles between adjacent sides of the cutout are
constrained to be right angles.  The number of sides has been limited to four and the sides must
be parallel and perpendicular to the frames and longerons.

Type 8 Double Lap Joint Repair

The Start point refers to the lower left corner of the cutout in the coordinate system defined as
starting at the lower left corner of the repair boundary (or “damage extent”).  The Cutout
Geometry is simply the size of the cutout.

The OK  button updates the current model with any information entered in the window and then
closes the window.  The Cancel button exits the window without saving any new entries.
Finally, the Help button retrieves help appropriate to this window.

For the type 8 repair, repair over a double lap joint, the first drawn cutout is in the upper skin.
RAPID will automatically move the cutout to align with the edge of the upper skin.  The user
must then draw the cutout in the lower skin.  RAPID adjusts the width of the lower skin cutout to
match the upper skin cutout.
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7.6.5  Skin Properties     

This dialog window is used to define the material Properties of the skins and joint (if any), and
is manually invoked by clicking with the right mouse button on a skin or joint or by selecting the
tool bar icon.  If the current Repair Type contains more than one skin or also contains a joint,
then the properties for each of those layers must be defined before the window may be closed
with the OK  button.  For repairs over splice and butt joints, the Geometry must be entered as
indicated in the displayed drawing.  This dialog window will display only those fields which are
appropriate for the current repair type.

The OK  button updates the current model with any information entered in the window and then
closes the window.  The Cancel button exits the window without saving any new entries.
Finally, the Help button retrieves help appropriate to this window.
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7.6.6  Fastener Global Properties     

This dialog window is used to enter the fastener information for the repair.  The sides are
numbered starting at the left side and continuing clockwise, the rows on each side are numbered
starting at the edge of the cutout and moving outward, and the fasteners are numbered in each
row on each side in a clockwise fashion as shown in the figure below.
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Under the Pitch and Edge Distance (in) section of the dialog window, the user specifies the
pitch and edge distances of the fasteners, which otherwise default to the settings selected in the
program setup.  These values are bound by the min/max values stored in the Advisory System as
determined by the fastener diameter of the type 1 fastener (defined below in the Fastener Types
dialog).  In models with stiffener effects and/or joints with existing fasteners, the pitch is fixed to
that of the existing fasteners.

The doubler properties are entered in the Doubler Information  section of this dialog window.
For each doubler layer selected using the Layer Object combination box, the user selects the
material and thickness using the Material  and Thickness combination boxes, respectively.  For
each side of the repair listed in the Fastener Rows per Side section, the user enters the number
of fastener rows in the associated edit field.  Based on the pitch, edge distances of the fasteners,
and the number of fastener rows per repair side, RAPID will automatically determine the
appropriate doubler geometry. For repair configurations that must be symmetric, some of the
Fastener Rows per Side entries will be grayed out. The Right and/or Bottom side will be
grayed out and will display the same number of fastener rows per side as entered for the Left
and/or Top side.

For repair type 1, the internal doubler should be larger than the external doubler.  The internal
doubler should be sized such that the single outermost fastener row passes through the skin and
the internal doubler as shown in the figure below.

External
Doubler

Skin Cutout

Internal
Doubler

External Doubler

Skin Cutout
Internal Doubler

Skin

Outermost
Fastener Row

Skin Cutout

Outermost
Fastener Row

Outermost
Fastener Row

Outermost
Fastener Row

For repair type 2, the external doubler 2 should be larger than the external doubler 1.  The
doublers should be sized such that the single outermost fastener row passes through the skin and
the external doubler 2 as shown below.
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External
Doubler 1

External
Doubler 2

External Doubler 2

External
Doubler 1

Skin

Skin Cutout

Skin Cutout Outermost
Fastener Row

Outermost
Fastener Row

Skin Cutout

Outermost
Fastener Row

Outermost
Fastener Row

The user specifies the different types and styles of fasteners in the arrangement using the
Fastener Properties dialog, which is invoked by selecting the Define button in the Fastener
Types section of the dialog window.  Fastener types are defined by first entering the number of
fastener types desired in the No.  Fastener Types edit field and then associating a type number
with style and size in the Type #, Style and Diameter combination boxes.

7.6.6.1  Selecting and Changing Fastener Types

To change fastener types, they must first be defined in the Fastener Properties dialog which
may be invoked from the Fastener Global Properties dialog.  Any number of fasteners may be
simultaneously changed to a predefined type.  Multiple fasteners are selected by holding the shift
key while clicking on desired fasteners.  To select a rectangular region of fasteners, while
holding the shift key, click and hold the left mouse button and drag the mouse to draw a
rectangle around a group of fasteners.  Releasing the mouse button then toggles the selection
state of each of the enclosed fasteners.  Subsequently clicking the right mouse button will invoke
the Fastener Types dialog through which the new fastener type may be selected.
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7.6.7  Text     

The text tool, available both as an icon button and in the Design pull-down menu, switches the
mouse pointer to Text input mode.  The text tool is used to annotate the drawing.  After selecting
this tool, text may be entered directly on the drawing at the location indicated by the next click of
the left mouse button.

7.7  Tools Menu Listing

7.7.1  Grid Scale

The grid scale can be adjusted to accommodate the size of the repair.  This is done by selecting
the Grid Scale menu item from the Tools pull-down menu, and then entering an appropriate
number of inches per displayed grid.  As a convenience, this dialog is automatically invoked the
first time the repair boundary is defined.
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7.7.2  Grid (on/off)

The Grid (on/off)  option in the Tools pull-down menu is used to turn the display of grid lines on
and off in the drawing window.

7.7.3  Snap to Grid

The Snap to Grid option in the Tools menu, if selected, causes drawing objects to “snap” to the
nearest fifth of a grid when drawn, moved, or resized.

7.7.4  Drawing Auto Size

The Drawing auto size option in the Tools menu, if selected, causes drawing to automatically
resize to fit the available display area.

7.7.5  Cutout Auto Size

The Cutout auto size option in the Tools menu resizes the cutout to fit within the fasteners,
subject to the edge distance constraint.

7.7.6  Program Setup
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7.7.6.1  File Locations (RAPID Setup)

This window is used to set default quantities used in RAPID.  It is not expected that the typical
user will need to modify these values on a regular basis; thus, this dialog can only be invoked
from the Tools pull-down menu and not from the button bar.  The data entered in this dialog is
stored in the RAPID.INI file which is read when RAPID is started.  The OK  button is used to
update the RAPID.INI file when changes are made to the window.  If the window is closed by
selecting Cancel, then updates to the entry fields will be ignored and will not be saved.

The data in the Fastener Arrangements section of this window is used in the Fastener
Arrangement Window to determine the number and placement of the repair fasteners.

7.7.6.2  Generate Load Spectra
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The RAPID Loads Setup is used to select which load spectra (generic narrow-body aircraft or
generic wide-body aircraft) will be generated.  These spectra can occupy considerable disk
space, and so only those which are required should be generated.

7.7.6.3  Defaults

There are four selections within the Defaults menu in the Program Setup item in the Tools pull-
down menu.  The General selection is not currently active.  The three other selections are
described in the following subsections.
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7.7.6.3.1  Load/Stress Spectrum Inputs

  

  

This dialog window, the three forms of which are displayed above, is used to select the stress
spectrum applied during the damage tolerance analysis.  The Equivalent Stress defines the
constant stress amplitude at the repair location.  See section 3 and the Analysis Methods
Document for further details on the equivalent stress.  If the equivalent stress is supplied, then
the other input fields are not used.  Otherwise, the Stress Spectrum is selected from one of the
RAPID Calculated spectra or from a User Specified file.  The user input stress spectrum must
be in one of the two following ASCII text file formats.  Examples of these files are included with
the RAPID distribution as PSEUDO.SSF and CYCLES.SSF for pseudo-flights and cycle-by-
cycle, respectively.

1. Pseudo-Flights (in repeatable flight sequence)
mtype
mflt
ifltseq1 ifltseq2 ifltseq3 … ifltseqmflt

mcyc1

Smin1 Smax1 Smin2 Smax2 … Sminmcyc1 Smaxmcyc1
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mcyc2

Smin1 Smax1 Smin2 Smax2 … Sminmcyc1 Smaxmcyc2

...
mcycmtype

Smin1 Smax1 Smin2 Smax2 … Sminmcyc1 Smaxmcycmtype

where mtype is the number of different flight types specified (maximum=20)
mflt is the number of flights in the spectrum (maximum=6000)
ifltseq contains the sequence of the flight types
mcyc is the number of cycle pairs for the flight type (maximum=1000)
Smin is the minimum stress
Smax is the maximum stress

2. Cycle-by-Cycle Stresses (in repeatable block)
mflt
mcyc1

Smin1 Smax1 Smin2 Smax2 … Sminmcyc1 Smaxmcyc1

mcyc2

Smin1 Smax1 Smin2 Smax2 … Sminmcyc1 Smaxmcyc2

...
mcycmtype

Smin1 Smax1 Smin2 Smax2 … Sminmcyc1 Smaxmcycmtype

where mflt is the number of flights in the spectrum (maximum=6000)
mcyc is the number of cycle pairs for the flight type (maximum=1000)
Smin is the minimum stress
Smax is the maximum stress

For the user defined spectrum, Rainflow Counting and Range Truncation Level must also be
specified, as documented in the Analysis Methods Document.

The input is parsed by RAPID according to the following flow chart.
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Equivalent
Stress Value
Provided by

User?

Generic
Stress

Spectrum
Used?

Calculate
Equivalent

Stress?

Write to DADTA User
Input File

NO

NOYES

YES

NO

YES

Enter Stress
Spectrum File with
Required Format

Set Equivalent
Stress Value = 0.0;

Set Crack
Growth Method = 2

Set Crack
Growth Method = 1
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7.7.6.3.2  Report Options

The Report Options dialog is used to select which portions of the report will be printed. A
checked box indicates that the associated item will be included in the printed RAPID repair
report.

7.7.6.3.3  Damage Tolerance Options

This screen is used to set the options for damage tolerance analysis. Both Simplified and Cycle-
by-Cycle methods are available.
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The user may select between two Center Hole Options for the crack growth along with a corner
hole scenario, which is always analysed, as defined below:

a. Scenario Type 1 (Center Hole) –

 

ý0.05″

  0.005″  0.005″

 
b. Scenario Type 2 (Center Hole) –

 
ý0.05″  0.005”

 
c. Scenario Type 3 (Corner Hole) - Always Performed

 

 0.05″

  0.005″  0.005″

For the current version, the program is restricted to assuming a non-visual inspection method.
The crack growth method and retardation flags are set as documented in the Analysis Methods
Document.

The Operating Pressure Differential is used to define the limit load condition.  See section 3
and the Analysis Methods Document for further details on the limit load condition.

A check box is provided to select output of beta values and corresponding crack lengths in the
analysis output.

7.7.7  Database

The Database menu section of the Tools menu contains Materials and Fasteners menu
selections, which are described in the following subsections.
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7.7.7.1  Materials Database

This window is used to review and add to the database of materials available for analysis.  There
is no icon button on the button bar of the main RAPID MDI window for this dialog window; it
must be opened from the Database menu item in the Tools menu.

A da/dN Data File entry is included for adding the required da/dN data for user defined records.
It is grayed-out when displaying RAPID defined records.

The terms are defined as follows:

KIc = Plane strain fracture toughness

C, q, p = Coefficients of the Walker crack growth rate equation

( )[ ]da

dN
C R K

q p

= −1 max

where

Kmax = the stress-intensity factor associated with the maximum stress in the stress
spectrum.

Ftu = Allowable tensile stress
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Fty = Allowable tensile yield stress at permanent strain = 0.002

Fcy = Allowable compressive yield stress at permanent strain = 0.002

Fsu = Allowable ultimate stress in pure shear (this value represents the average shearing
stress over the cross section)

Fbru = Allowable ultimate bearing stress

e/D = Ratio of edge distance to hole diameter

Fbry = Allowable bearing yield stress

Kc = Critical plane stress fracture toughness, a measure of fracture toughness at point of
crack growth instability

If K c is not present, then it will be automatically calculated using the
NASA/FLAGRO 2.0 equation:

K

K
B ec

Ic
k

A t
tk= +

−
1 0

2( )

where

t0 = 2.5 ( KIc/Fty )
2

The text in the upper right of the dialog indicates whether the current material is a RAPID-
defined record or a user-defined record.  Only user-defined records can be deleted with the
Delete button.  The New button clears the entries to allow user-defined data to be entered, which
can then be saved by selecting the Save button or discarded by selecting the Cancel button.  The
Edit  button is used to return the dialog back to the default query and edit state after New has
been selected.  The OK  button saves the current entry (if user defined) and closes the window.

When adding a new entry, if the Thickness (min) field is overwritten and then that field is exited
by pressing the tab key or selecting another field with the mouse, then the following dialog
window will appear.  This allows the user to choose between adding properties at a new
minimum thickness or changing the value of the minimum thickness for the current record.

When the Delete button is selected, the following dialog appears to allow the user to choose
between deleting the entire record or simply the material strength properties for the displayed
material thickness.
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7.7.7.2  Fastener Database

This window is used to review and add to the database of fasteners available for analysis.  There
is no icon button on the button bar of the main RAPID MDI window for this dialog window; it
must be opened from the pull-down Database menu item in the Tools menu.

The text in the upper right of the dialog indicates whether the current fastener is a RAPID-
defined record or a user-defined record.  Only user-defined records can be deleted with the
Delete button.  The New button clears the entries to allow user-defined data to be entered, which
can then be saved by selecting the Save button or discarded by selecting the Cancel button.  The
Edit  button is used to return the dialog back to the default query and edit state after New has
been selected.  The OK  button saves the current entry (if user defined) and closes the window.

When adding a new entry, if the Fastener Diameter field is overwritten and then that field is
exited by pressing the tab key or selecting another field with the mouse, then the following
dialog window appears.  This allows the user to choose between adding properties at a new
fastener diameter or changing the value of the fastener diameter for the current record.
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Similarly, when adding a new entry, if the Material Thickness field is overwritten and then that
field is exited by pressing the tab key or selecting another field with the mouse, then the
following dialog window appears.  This allows the user to choose between adding properties at a
new material thickness or changing the value of the material thickness for the current record.

When the Delete button is selected, the following dialog allows the user to choose between
deleting the entire record, the portion of the data associated with the displayed diameter, or the
portion of the data associated with the displayed material thickness.
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7.7.8  Moving and Resizing Graphical Objects

7.7.8.1  Moving an Object

Objects may be moved as follows.  First, select the pointer tool from the Tools palette and then
click within the object to select the object.  Once selected, the object will display small black
squares, called “handles” at its four corners.  The mouse can then be moved to an edge (not a
corner) of the object, at which point the cursor will change from an arrow to a cross with four
arrows, as shown above.  When the crossed arrow cursor is displayed, depress the left mouse
button and, while continuing to depress the left mouse button, move the mouse to reposition the
object.  When the desired location is reached, release the left mouse button.

An object may not be moved if its position has been frozen due to the existence of dependent
objects.  For example, cutouts cannot be moved after fasteners are defined, since that would
require that the fasteners be regenerated.
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7.7.8.2  Resizing a n Object

Objects may be resized as follows.  First, select the pointer tool from the Tools palette and then
click within the object to select the object.  Once selected, the object will display small black
squares, called “handles” at its four corners.  The mouse can then be moved to a corner (not an
edge) of the object, at which point the cursor will change from an arrow to a double-headed
arrow, as shown above.  When the double-headed arrow cursor is displayed, depress the left
mouse button and, while continuing to depress the left mouse button, move the mouse to resize
the object.  When the desired size is achieved, release the left mouse button.

An object may not be resized if its position has been frozen due to the existence of dependent
objects.  For example, cutouts can not be resized after fasteners are defined, since that would
require that the fasteners be regenerated.

7.8  Analysis Menu Listing

The Analysis menu contains selections for previewing, running, and displaying the results of the
static and damage tolerance analyses.  The menu items are documented in the following sub-
sections.
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7.8.1  Static Analysis

The Static Analysis Menu Listing contains options directly related to running the static analysis.

The input can be displayed by selecting the Create/View Static Input File submenu options
within the Static Analysis menu item.  The Static Analysis input file format is shown here (note
that the RAPID GUI makes it unnecessary for the user to directly interact with this input file):

REPAIR CONFIGURATION TYPE (1 External Doubler)
            3
SKIN/DAMAGE : Number of Layers
              1
         SKIN : Mat.Type
               2024-T3 CLAD SHEET
              # of Sides, Thickness, FTU (ksi), Modulus (ksi)
                  4     0.063        62     10500
SIDE 1     : LENGTH, FSU
                    8    38
              MAX# OF FASTENER TYPES
               2
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             24            1.175    0.191
               2             24            1.496   0.1875
              MAX# OF ROWS
               3
              NUMBER OF FASTENERS PER ROW
                16
                16
                16
SIDE 2     : LENGTH, FSU
                   18    38
              MAX# OF FASTENER TYPES
               1
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             96            1.175    0.191
              MAX# OF ROWS
               4
              NUMBER OF FASTENERS PER ROW
                24
                24
                24
                24
SIDE 3     : LENGTH, FSU
                    8    38
              MAX# OF FASTENER TYPES
               2
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             24            1.175    0.191
               2             24            1.496   0.1875
              MAX# OF ROWS
               3
              NUMBER OF FASTENERS PER ROW
                16
                16
                16
SIDE 4     : LENGTH, FSU
                   18    38
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              MAX# OF FASTENER TYPES
               1
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             96            1.175    0.191
              MAX# OF ROWS
               4
              NUMBER OF FASTENERS PER ROW
                24
                24
                24
                24
REPAIR       : Number of Layers
              1
EXT DBL1   : Mat.Type
               2024-T3 CLAD SHEET
              # of Sides, Thickness, FTU (ksi), Modulus (ksi)
                  4     0.071        62     10500
SIDE 1     : LENGTH, FSU
                   16    38
              MAX# OF FASTENER TYPES
               2
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             24            1.025    0.191
               2             24            1.686   0.1875
              MAX# OF ROWS
               3
              NUMBER OF FASTENERS PER ROW
                16
                16
                16
SIDE 2     : LENGTH, FSU
                   24    38
              MAX# OF FASTENER TYPES
               1
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             96            1.025    0.191
              MAX# OF ROWS
               4
              NUMBER OF FASTENERS PER ROW
                24
                24
                24
                24
SIDE 3     : LENGTH, FSU
                   16    38
              MAX# OF FASTENER TYPES
               2
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             24            1.025    0.191
               2             24            1.686   0.1875
              MAX# OF ROWS
               3
              NUMBER OF FASTENERS PER ROW
                16
                16
                16
SIDE 4     : LENGTH, FSU
                   24    38
              MAX# OF FASTENER TYPES
               1
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             96            1.025    0.191
              MAX# OF ROWS
               4
              NUMBER OF FASTENERS PER ROW
                24
                24
                24
                24
PITCH   : Circumferential, Longitudinal
               1.0000        1.0000
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BENDING : Q Ratio
           2.0

Definitions of Input Parameters:

• FSU - Allowable ultimate stress in pure shear

• FTU - Allowable ultimate tension stress

• MAX # OF FASTENER TYPES - Maximum number of different types of fastener for
that side (maximum = 10)

• FASTENER TYPE - Material type of that particular type of fastener
1 = Aluminum
2 = Titanium
3 = Steel

• MAX # OF ROWS - Maximum number fastener rows on that side (maximum=4)

• Q RATIO - Use 2.0 in the present version of RAPID

The analysis is performed by selecting the Run Static Analysis submenu item.  The analysis
runs in a DOS window.  The progress is automatically monitored by RAPID, while displaying
the following screen.

The static analysis will complete within seconds on all but the very slowest machines and then
display a summary of the results.
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The output can be displayed by selecting the Tabular Results submenu item as shown below.

From the static analysis, the margins of safety (MS) based on the repair doubler allowable and
the fastener joint allowables are calculated to determine the adequacy of the repair as follows.
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MS < 0: Repair is statically inadequate
MS = 0: Repair is marginally adequate
MS > 0: Repair is statically adequate

For repairs that are statically inadequate and marginally adequate, the repair should be
redesigned.

7.8.2  Damage Tolerance

The Damage Tolerance Menu Listing contains options directly related to running the damage
tolerance analysis.  The damage tolerance analysis predicts the residual strength and crack
length, and recommends an inspection interval.  The analysis is performed for all four sides of
the repair, at center, and at corner fasteners.  The locations of these critical fasteners are
highlighted in red in the RAPID drawing window.

The input can be displayed and edited by selecting the Create/View DTA Input File submenu
options within the Damage Tolerance menu item.  This selection will automatically invoke the
Damage Tolerance Options and Load/Stress Spectrum dialogs if they are not yet completed
for the current model.  The Damage Tolerance input file format is shown here (note that the
RAPID GUI makes it unnecessary for the user to directly interact with this input file):

REPAIR CONFIGURATION TYPE (1 External Doubler)
            3
      SKIN: Mat. Type
          2024-T3 CLAD SHEET
          Mat.Type, Thickness, Modulus(ksi), C,    P,   Kc(ksi*sqrt(in)),Yield S( ksi),FTU
            2     0.063     10500    9.01566e-10     3.68842     152.4        45        62
          EDSX, EDSY
             0.5    0.5
CUTOUT  : X Direct., Y Direct.
                18          8
EXT DBL1: Mat. Type
           2024-T3 CLAD SHEET
          Mat.Type, Thickness, Modulus(ksi), C,    P,   Kc(ksi*sqrt(in)),Yield S( ksi)
            2     0.071     10500    9.01566e-10     3.68842     152.4        45
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PITCH   : X Direct., Y Direct.
            1.0000     1.0000
FSTNR   : Max # In Col
             4
          Material, Hole Diameter  *(1-AL, 2-TI, 3-Steel)
             1     0.19100
             1     0.19100
             1     0.19100
             1     0.19100
          Max # In Row, Crit #, Crit #, Overlap, L2R
              24          12      24       0      0
STIFF   : Max #, POS,   CSA, Yng.Mod.,  HPit
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
          Dblr Id
           1
PROXMTY : Flag,Delta X,Delta Y,IQS, Sub.X, Sub.Y,IQP, Prx.X, P rx.Y, EDPX, EDPY
            0    0.000   0.000  1  24.000  16.000  1   0.000   0.000 0.500 0.500
FUSELAGE: Eqv.Stress, Press. Diff, Radius
            16.0381       8.6     120.000
CRK GRW : RunType,Crk.Scnr,Vsl.Meth,Method,Rtd.Flag,TipA,TipB,ICL
            2         1       0        1      0    0.050 0.000  0
REPAIR CONFIGURATION TYPE (1 External Doubler)
            3
      SKIN: Mat. Type
          2024-T3 CLAD SHEET
          Mat.Type, Thickness, Modulus(ksi), C,    P,   Kc(ksi*sqrt(in)),Yield S( ksi),FTU
            1     0.063     10500    6.76125e-10      3.7198     152.4        45        62
          EDSX, EDSY
             0.5    0.5
CUTOUT  : X Direct., Y Direct.
                 8         18
EXT DBL1: Mat. Type
           2024-T3 CLAD SHEET
          Mat.Type, Thickness, Modulus(ksi), C,    P,   Kc(ksi*sqrt(in)),Yield S( ksi)
            1     0.071     10500    6.76125e-10      3.7198     152.4        45
PITCH   : X Direct., Y Direct.
            1.0000     1.0000
FSTNR   : Max # In Col
             3
          Material, Hole Diameter  *(1-AL, 2-TI, 3-Steel)
             3     0.19000
             3     0.19000
             3     0.19000
          Max # In Row, Crit #, Crit #, Overlap, L2R
              16           9      16       0      0
STIFF   : Max #, POS,   CSA, Yng.Mod.,  HPit
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
          Dblr Id
           1
PROXMTY : Flag,Delta X,Delta Y,IQS, Sub.X, Sub.Y,IQP, Prx.X, P rx.Y, EDPX, EDPY
            0    0.000   0.000  1  16.000  24.000  1   0.000   0.000 0.500 0.500
FUSELAGE: Eqv.Stress, Press. Diff, Radius
             9.2389       8.6     120.000
CRK GRW : RunType,Crk.Scnr,Vsl.Meth,Method,Rtd.Flag,TipA,TipB,ICL
            2         1       0        1      0    0.050 0.000  1

Definitions of Input Parameters:

• REPAIR CONFIGURATION TYPE - Type of Repair Configuration
1 = One Internal Doubler, 1 External Doubler
2 = Two External Doublers
3 = One External Doubler
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• SCENARIO TYPE - Type of Crack Scenario
1 = A single through crack emanating from a center hole on a sheet, two equal length

through cracks emanating from holes after first crack grew into the adjacent hole

2 = Two different length through cracks emanating from a center hole on a sheet

3 = A single through crack emanating from a corner hole on a sheet, two same length
through cracks emanating from holes after first crack grew into the adjacent hole

• VSL.METH - Visual Inspection Flag; applicable only to Scenario Type 3
0 = Inspection Method is not visual
1 = Inspection Method is visual

• METHOD - Type of Crack Growth Method
1 = Simplified Method
2 = Cycle-by-Cycle Method (Uses Stress Spectrum)

• RETARD.FLAG - Retardation Flag; applicable only to the Cycle-by-Cycle Method
0 = No Retardation (Default)
1 = Retardation

The analyses are performed on all four sides of the repair at the center and corner fasteners
automatically.

The analysis is performed by selecting the Run Damage Tolerance Analysis submenu item.
The analysis runs in a DOS window.  The progress is automatically monitored by RAPID, while
displaying the following screen.
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Depending on the computer and on the particular repair model, the damage tolerance analysis
will complete within minutes or hours.  On a typical Pentium-class computer, the analysis
usually consumes less than 5 minutes.  The progress of the crack growth can be observed by
bringing the DOS window (shown above) to the foreground.  When the analysis is complete, the
following dialog is displayed.

The output can be displayed by selecting the Tabular Results submenu item as shown below.

For the center fastener and for the corner fastener, the damage tolerance output consists of two
parts.  In the first part, the crack length, crack growth life, and residual strength are provided as
shown below.
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               DAMAGE TOLERANCE ANALYSIS RESULTS OF THE REPAIR
               -----------------------------------------------

           *****   CENTER FASTENER   *****

           (A) CRACK GROWTH LIFE AND RESIDUAL STRENGTH:

               EDGE-TO-TIP         CRACK GROWTH         RESIDUAL
               CRACK LENGTH            LIFE             STRENGTH
                 (INCHES)            (FLIGHTS)            (KSI)
               ------------        ------------       ------------
                  0.05000                  0            198.83429
                  0.12590              15615            195.59140
                  0.20180              30148            189.75919
                  0.27770              42744            181.50046
                  0.35360              53320            172.89491
                  0.42950              62139            164.65282
                  0.50540              69487            156.68164
                  0.58130              75551            148.17274

In the second part, the inspection threshold (first inspection) is provided followed by a table with
the detectable crack length and corresponding inspection interval as shown below.

           (B) NDI INSPECTION INTERVAL:

               AFTER REPAIR INSTALLATION, FIRST INSPECTION IS AT  50226 FLIGHTS.

                DETECTABLE           INSPECTION
               CRACK LENGTH           INTERVAL
                 (INCHES)             (FLIGHTS)
               ------------          ----------
                  0.05000              50226
                  0.10000              45082
                  0.15000              40111
                  0.20000              35324
                  0.25000              31152
                  0.30000              27300
                  0.35000              23817
                  0.40000              20870
                  0.45000              18164
                  0.50000              15744
                  0.55000              13701
                  0.60000              11862
                  0.65000              10289
                  0.70000               9120
                  0.75000               8192

For the damage tolerance analysis, two initial flaw patterns are available:

• Case 1: A single through crack emanating from the critical fastener hole.  The primary
crack has a length of ap = 0.05″.

• Case 2: Two asymmetric through cracks emanating from the critical fastener hole.  The
primary crack has a length of ap = 0.05″, and the secondary crack has a length of
as = 0.005″.
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Case 2
Initial Flaw

Subsequent Growth

as = 0.005 ap = 0.05

a = 0.005Crack Grows
Into Hole

″ ″

″

″ap = 0.05

Case 1
Initial Flaw

Subsequent Growth

Crack Grows
Into Hole

a = 0.005a = 0.005 ″″

The analysis defaults to Case 1.  To use Case 2, the user must select the Preview button in the
DTA  section of the dialog window.  The DTA input file will be displayed in the embedded text
window.  In the last line of this file, the user must manually change the default entry of the crack
growth configuration type from 1 to 2.  The user must select the Save button and then the
Analysis button to conduct a damage tolerance analysis using Case 2.

Damage tolerance results can also be viewed graphically as Residual Strength vs. Crack
Length, Crack Length vs. Number of Flights, and Inspection Interval vs. Detectable Crack
Length.  These plots are available from within the Damage Tolerance submenu in the Analysis
pull-down menu on the main RAPID MDI window as discussed in the following subsections.

7.8.2.1  Damage Tolerance Options

The Damage Tolerance Options dialog is described in section 7.7.6.3.3.

7.8.2.2  Load/Stress Spectrum Information

The Load/Stress Spectrum Information dialog is described in section 7.7.6.3.1.
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7.8.2.3  Proximity Data

The Proximity Data is used to define the size and location of a nearby repair so that its influence
may be considered in the analysis.  The location of the nearby (proximity) repair is indicated by
selecting a reference corner fastener in each repair, along with the longitudinal (x) and
circumferential (y) distances between those reference points.  The geometry of the nearby repair
can be entered directly under the Proximity Repair Dimensions selection or may be determined
automatically via reference to an existing repair model Filename.  The Select button opens a file
dialog to select a file from disk.

7.8.2.4  Residual Strength vs. Crack Length Plot
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This window displays the residual strength versus crack length plot from the damage tolerance
analysis for all four sides of the repair.  (For a symmetrical repair, only sides 2 and 3 are
available).  The yield strength of the skin, Fty, is indicated by the solid horizontal line and the
limit load condition is indicated in the legend key.  This window can be invoked only from the
Damage Tolerance section of the Analysis pull-down menu in the main RAPID MDI.  The
plots can be generated for longitudinal cracks in the center and corner fasteners above and below
the cutout and for circumferential cracks in the center and corner fasteners to the left and right of
the cutout.  If there are four points, then the plot will not be generated and a message box will be
displayed.

Any portion of this window may be enlarged or “zoomed” by depressing the left mouse button at
one corner of the desired area and then, while continuing to depress the left mouse button,
dragging the mouse to the opposite corner of the desired area, release the mouse button.  The
view will automatically enlarge the selected area to fill the plot window.  To return to a non-
zoomed view, simply depress the right mouse button within the plot window.

To print the plot, select the print button on the icon bar, or select the Print  menu item within the
File menu.  The Plot window must be the active window to be printed.



71

7.8.2.5  Crack Length vs. # of Flights Plot

This window displays the crack length versus number of flights plot from the damage tolerance
analysis for all four sides of the repair.  (For a symmetrical repair, only sides 2 and 3 are
available.) The predicted crack growth life at each of the critical fasteners is indicated in the
legend key.  This window can be invoked only from the Damage Tolerance section of the
Analysis pull-down menu in the main RAPID MDI.  The plots can be generated for longitudinal
cracks in the center and corner fasteners above and below the cutout and for circumferential
cracks in the center and corner fasteners to the left and right of the cutout.  If there are four
points, then the plot will not be generated and a message box will be displayed.

The crack grows edge to tip and then tip to tip as defined in the figure below.
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Edge-To-Tip Crack Length

Tip-To-Tip Crack

Crack Grows
Into Hole

Initial Flaw

Subsequent Growth

Any portion of this window may be enlarged or zoomed by depressing the left mouse button at
one corner of the desired area and then, while continuing to depress the left mouse button,
dragging the mouse to the opposite corner of the desired area, release the mouse button.  The
view will automatically enlarge the selected area to fill the plot window.  To return to a non-
zoomed view, simply depress the right mouse button within the plot window.

To print the plot, select the print button on the icon bar or select the Print  menu item within the
File menu.  The Plot window must be the active window to be printed.

7.8.2.6  Inspection Interval vs. Detectable Crack Length Plot
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This window displays the inspection interval versus detectable crack length plot from the
damage tolerance analysis for all four sides of the repair.  (For a symmetrical repair, only sides 2
and 3 are available.) The first inspection as determined by the damage tolerance analysis at each
of the critical fasteners is indicated in the legend key.  This window can be invoked only from
the Damage Tolerance section of the Analysis pull-down menu in the main RAPID MDI.  The
plots can be generated for longitudinal cracks in the center and corner fasteners above and below
the cutout and for circumferential cracks in the center and corner fasteners to the left and right of
the cutout.  If there are four points, then the plot will not be generated and a message box will be
displayed.

Any portion of this window may be enlarged or zoomed by depressing the left mouse button at
one corner of the desired area and then, while continuing to depress the left mouse button,
dragging the mouse to the opposite corner of the desired area, releasing the mouse button.  The
view will automatically enlarge the selected area to fill the plot window.  To return to a non-
zoomed view, simply depress the right mouse button within the plot window.

To print the plot, select the print button on the icon bar or select the Print  menu item within the
File menu.  The Plot window must be the active window to be printed.
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7.8.3  RAPID Repair Report     

The RAPID Repair Report may be displayed (and subsequently printed) by selecting the report
button on the icon bar or by selecting the Report menu item within the Analysis menu.  While
the report is displayed, it may be printed by selecting Print from the File menu.

This will invoke the Report Print Options dialog through which the user may choose the
components of the report to print.
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For the current version, the RAPID Repair Report is read-only.  The report contains the
following information in sequence: the RAPID.TMP file (data input echo), the input file for the
static analysis, the results from the static analysis, the input file for damage tolerance analysis,
the tabular results of the damage tolerance analysis, the program limitations (section 3), and
optionally, a drawing of the repair configuration and the three analysis plots for each side of the
repair.  It can be saved to any named file and later reopened from within the Report module.

The RAPID Repair Report is formatted using Microsoft’s version of Rich Text Format (RTF),
which is compatible with most modern word processors.

7.9  Wind ow Menu Listing

The Window menu contains the standard window functions of Cascade, Tile, Arrange Icons,
and Close All options.  Refresh is also provided to force a redraw of the entire RAPID window.
Cascade arranges any open dialog windows within the RAPID MDI diagonally down the screen
from left to right.  Tile arranges dialog windows so that they are evenly distributed across the
screen.  Arrange Icons aligns minimized icons at the lower-left of the RAPID MDI screen.
Close All closes all currently open windows within RAPID.  In addition, if any RAPID models
are open, they will be listed within this menu for selection by the user.
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7.10  Help Menu Listing     

The Help menu contains Index, Using help, Readme Information, Disclaimer, and About
selections.  Index displays the top-level help index, with links to the entire RAPID help and
advisory systems.  Using help displays general information on how to use help systems within
Windows programs.  Readme Information displays the RAPID README.WRI fi le which
contains general notes and corrections concerning the RAPID GUI and analyses.  Disclaimer
redisplays the disclaimer statement which appears each time RAPID is started.  About presents
the RAPID copyright notice.

7.10.1  Readme Information

This window provides the most updated information or release notes regarding the graphical user
interface and program limitations for the latest current version of RAPID.  It is recommended
that the user reads this information before using RAPID.  The contents match those in section 3
of this manual.
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8.  Example Problems

Two repair examples are shown to illustrate the usage of RAPID.  The first is a common skin
repair with one doubler and no stiffener or joint effects.  The second example is of a single
doubler repair over a longitudinal butt joint.

8.1  Single External Doubler Example

The following is an example of a rectangular cutout with a single external doubler repair.  The
cutout is 8 inches high by 18 inches wide and is located 5 inches from the adjacent bottom
longeron and 4 inches from the adjacent left frame.  The doubler size and fastener locations are
automatically determined by the default pitch and edge distance settings together with the
selected number of fastener rows per side.  The layout and materials are shown in the following
figure.

Edge distance = 0.5″

Longeron

Frame Doubler

Skin Cutout

18.0″

24.0″

26.0″

Skin

16.0″8.0″18.0″

Skin:
2024-T3 Clad Sheet
Thickness = 0.063″

Doubler:
2024-T3 Clad Sheet
Thickness = 0.071″

Rivets:
NAS1097-E6
HL326-6

Pitch = 1.0″
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8.1.1  Create the New RAPID Model

The first step is to start the RAPID program from the Windows Program Manager.  Once
launched, RAPID will display its main MDI window, as shown below.  All of the dialog
windows shown in this example appear as sub-windows within the RAPID MDI window.

To begin a new repair, select New from the File menu.
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The Setup dialog can be selected from the Tools --> Program Setup --> File Locations pull-
down menu and is shown below.  There is no need to use the Setup dialog unless the user wishes
to change the default RAPID configuration.  The fastener pitch and edge distances will be used
by the Fastener Arrangement dialog window to automatically determine the number and
arrangement of the fasteners and the sizes of the doublers in the repair.  The defaults can be
changed here or on a model to model basis within the Fastener Arrangement dialog window
which will be used later.  If any of the values are changed, then the OK  button must be selected
for the values to be written to the RAPID.INI file, which stores the RAPID defaults.  In this
example, we will retain the defaults and simply close the window by clicking on the Cancel
button.

The first dialog window in which data will be input is the Aircraft/General Information
Window, shown below with example input data already entered.  This dialog window can be
selected either from the MDI button bar, or from the General pull-down menu.  Once the data is
entered, the OK  button must be selected to store the data in the current model and close the
dialog window.
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8.1.2  Define Repair Type and Location

Next, the repair type is selected from the Repair Type dialog window, as show below.  This
dialog window can be selected either from the icon button bar or from the General pull-down
menu.  One Rectangular External doubler is selected from the available options, and the
selection is saved and the dialog window is closed by pressing the OK  button.

The Damage Location dialog window is invoked to enter the location of the damage on the
structure and is shown below.  This dialog window can be selected either from the icon button
bar or from the General pull-down menu.
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The distances entered on this dialog window refer to regions of the aircraft as depicted in the
zone diagram which can be displayed by selecting the Zones button and which is shown in the
following figure.  As with all of the other dialogs with OK  buttons, remember to save the data
and close the dialog window by pressing the OK  button after completing the entries.

8.1.3  Draw the Repair

After entering the damage location information, the Grid Scale dialog window will be
automatically displayed to set the drawing scale to accommodate the size of the planned repair.
The grid scale can be reset at any other time by selecting the Grid scale menu item from the
Tools pull-down menu.
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For the depicted 640 by 480 screen resolution, a grid scale of 4 inches per grid will result in a
workspace of adequate size to draw the largest included object, the damage extent, which is 26
inches wide by 18 inches high.

8.1.3.1  Define the Repair Boundary

The repair boundary tool is used to draw the region defined by the two frames and two longerons
which are just outside of the region of the repair, as defined by the doubler.

After selecting the repair boundary tool from the tool bar, the repair boundary is drawn by
clicking the left mouse button on one corner of the repair boundary and then, while continuing to
depress the left mouse button, dragging the mouse to the opposite corner of the repair boundary
and then releasing the left mouse button.  The changing size of the repair boundary is displayed
in the upper left of the display as the area is drawn.
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When the left mouse button is released, the Repair Boundary Information  window is
automatically displayed to input the frame and longeron labels, and to fine-tune the Overall
Distances in the Longitudinal  and Circumferential  Directions. A Stiffener ID should be
entered for each stiffener.
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8.1.3.2  Define Skin Properties     

Selecting Skin Properties from the Design menu or selecting the Skin Properties icon on the
button bar invokes the Skin Properties dialog window.

After entering the properties for the skin, pressing OK  updates the Drawing dialog window to
represent the local skin area as a red rectangle.
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8.1.3.3  Draw the Cutout

Next, the cutout is defined by selecting the cutout tool on the tool bar.

The cutout is drawn by clicking the left mouse button on one corner of the cutout, and then,
while continuing to depress the left mouse button, dragging the mouse to the opposite corner of
the cutout and then releasing the mouse button.  The size and location of the centroid with
respect to the left most frame and bottom longeron are displayed in the upper left of the display.
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When the left mouse button is released, the Cutout Geometry dialog window is automatically
displayed to allow manual correction of the dimensions.
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8.1.3.4  Create the Fasteners

The fastener arrangement is then defined by selecting the Fastener Properties tool from the
button bar or from the Design menu.

This invokes the Fastener Global Properties dialog window.  This dialog window is used to
change the default pitch and edge distances, and to enter the number of fastener rows per side of
each doubler.  Because this information is used by RAPID to automatically size the doublers, the
material and thickness of each doubler should also be entered.  For the current example, only one
external doubler is included.

Each of the two fastener types in the model should now be entered by pressing the Fastener
Types Define button to display the Fastener Properties input screen.  Enter 2 for the No. of
Fastener Types and then enter the Style and Diameter for each Type No.
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When the OK  button is selected in the Fastener Global Properties screen, the fasteners and
doubler are automatically generated and displayed in the workspace.

To change the desired fasteners to type 2, first select the selection tool from the Tools palette.

Then, while holding the shift key, click and hold the left mouse button and drag the mouse to
draw a rectangle around the fasteners which should be type 2.
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Releasing the mouse button then selects that group of fasteners.
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Click the right mouse button to change the fastener type of the selected fasteners using the
Fastener Types dialog window.

Select type 2 from the Fastener Type combo box, then click OK .

8.1.4  Run the Analyses

The analyses can then be run and the results viewed by using the Analysis pull-down menu.
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8.1.4.1  Static Analysis

Listed below is the input to the Static module as displayed by the Create/View Static Input File
menu item in the Static Analysis section of the Analysis pull-down menu:

REPAIR CONFIGURATION TYPE (1 External Doubler)
            3
SKIN/DAMAGE : Number of Layers
              1
         SKIN : Mat.Type
               2024-T3 CLAD SHEET
              # of Sides, Thickness, FTU (ksi), Modulus (ksi)
                  4     0.063        62     10500
SIDE 1     : LENGTH, FSU
                    8    38
              MAX# OF FASTENER TYPES
               2
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             24            1.175    0.191
               2             24            1.496   0.1875
              MAX# OF ROWS
               3
              NUMBER OF FASTENERS PER ROW
                16
                16
                16
SIDE 2     : LENGTH, FSU
                   18    38
              MAX# OF FASTENER TYPES
               1
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             96            1.175    0.191
              MAX# OF ROWS
               4
              NUMBER OF FASTENERS PER ROW
                24
                24
                24
                24
SIDE 3     : LENGTH, FSU
                    8    38
              MAX# OF FASTENER TYPES
               2
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             24            1.175    0.191
               2             24            1.496   0.1875
              MAX# OF ROWS
               3
              NUMBER OF FASTENERS PER ROW
                16
                16
                16
SIDE 4     : LENGTH, FSU
                   18    38
              MAX# OF FASTENER TYPES
               1
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             96            1.175    0.191
              MAX# OF ROWS
               4
              NUMBER OF FASTENERS PER ROW
                24
                24
                24
                24
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REPAIR       : Number of Layers
              1
EXT DBL1   : Mat.Type
               2024-T3 CLAD SHEET
              # of Sides, Thickness, FTU (ksi), Modulus (ksi)
                  4     0.071        62     10500
SIDE 1     : LENGTH, FSU
                   16    38
              MAX# OF FASTENER TYPES
               2
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             24            1.025    0.191
               2             24            1.686   0.1875
              MAX# OF ROWS
               3
              NUMBER OF FASTENERS PER ROW
                16
                16
                16
SIDE 2     : LENGTH, FSU
                   24    38
              MAX# OF FASTENER TYPES
               1
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             96            1.025    0.191
              MAX# OF ROWS
               4
              NUMBER OF FASTENERS PER ROW
                24
                24
                24
                24
SIDE 3     : LENGTH, FSU
                   16    38
              MAX# OF FASTENER TYPES
               2
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             24            1.025    0.191
               2             24            1.686   0.1875
              MAX# OF ROWS
               3
              NUMBER OF FASTENERS PER ROW
                16
                16
                16
SIDE 4     : LENGTH, FSU
                   24    38
              MAX# OF FASTENER TYPES
               1
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             96            1.025    0.191
              MAX# OF ROWS
               4
              NUMBER OF FASTENERS PER ROW
                24
                24
                24
                24
PITCH   : Circumferential, Longitudinal
               1.0000        1.0000
BENDING : Q Ratio
           2.0

The static analysis is then executed by selecting the Run Static Analysis menu item located in
the Static Analysis section of the Analysis pull-down menu.  When the analysis completes,
RAPID displays the Static Analysis Results Summary.
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The following shows the textual output produced by the static analysis and displayed by
selecting the Tabular Static Results menu item in the Static Analysis section of the Analysis
pull-down.  Note that the margins of safety for the doublers and the fasteners are all positive,
indicating that the chosen design is statically adequate.

                        STATIC ANALYSIS RESULTS OF THE REPAIR
                        -------------------------------------

 (A) MARGINS OF SAFETY:

     *** REPAIR DOUBLERS ***

           0.13

       MARGIN OF SAFETY IS POSITIVE.

       THE REPAIR DOUBLER IS STATICALLY ADEQUATE.

     *** FASTENER JOINTS ***

                LOAD LOST        LOAD RESTORED        MARGIN OF SAFETY
                  (LBS)              (LBS)            (NONDIMENSIONAL)
                ---------        -------------        ----------------

       SIDE 1     31248            64104                1.05
       SIDE 2     70308            98400                0.40
       SIDE 3     31248            64104                1.05
       SIDE 4     70308            98400                0.40

       SIDE 1:  MARGIN OF SAFETY IS POSITIVE.

                THE FASTENER JOINTS ARE STATICALLY ADEQUATE.

       SIDE 2:  MARGIN OF SAFETY IS POSITIVE.

                THE FASTENER JOINTS ARE STATICALLY ADEQUATE.

       SIDE 3:  MARGIN OF SAFETY IS POSITIVE.

                THE FASTENER JOINTS ARE STATICALLY ADEQUATE.

       SIDE 4:  MARGIN OF SAFETY IS POSITIVE.

                THE FASTENER JOINTS ARE STATICALLY ADEQUATE.
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 (B) SHEAR STRENGTHS:

                DOUBLER(S)           SKIN             MARGIN OF SAFETY
                   (LBS)             (LBS)            (NONDIMENSIONAL)
                ----------        ----------          ----------------

       SIDE 1      2698              2394                0.13
       SIDE 2      2698              2394                0.13
       SIDE 3      2698              2394                0.13
       SIDE 4      2698              2394                0.13

       SIDE 1:  MARGIN OF SAFETY IS POSITIVE.

                THE SHEAR STRENGTH OF THE REPAIR IS STATICALLY ADEQUATE.

       SIDE 2:  MARGIN OF SAFETY IS POSITIVE.

                THE SHEAR STRENGTH OF THE REPAIR IS STATICALLY ADEQUATE.

       SIDE 3:  MARGIN OF SAFETY IS POSITIVE.

                THE SHEAR STRENGTH OF THE REPAIR IS STATICALLY ADEQUATE.

       SIDE 4:  MARGIN OF SAFETY IS POSITIVE.

                THE SHEAR STRENGTH OF THE REPAIR IS STATICALLY ADEQUATE.

 (C) STIFFNESS:

                DOUBLER(S)           SKIN             STIFFNESS RATIO
                 (LBS/IN)          (LBS/IN)           (NONDIMENSIONAL)
                ----------        ----------          ----------------

       SIDE 1    745500            661500                1.13
       SIDE 2    745500            661500                1.13
       SIDE 3    745500            661500                1.13
       SIDE 4    745500            661500                1.13

       SIDE 1:  STIFFNESS RATIO IS BETWEEN 1 AND 1.5

                REPAIR STIFFNESS IS ACCEPTABLE.

       SIDE 2:  STIFFNESS RATIO IS BETWEEN 1 AND 1.5

                REPAIR STIFFNESS IS ACCEPTABLE.

       SIDE 3:  STIFFNESS RATIO IS BETWEEN 1 AND 1.5

                REPAIR STIFFNESS IS ACCEPTABLE.

       SIDE 4:  STIFFNESS RATIO IS BETWEEN 1 AND 1.5

                REPAIR STIFFNESS IS ACCEPTABLE.

 (D) FASTENER BENDING:

                     Q RATIO
                 (NONDIMENSIONAL)
                 ----------------

       SIDE 1        0.00
       SIDE 2        0.70
       SIDE 3        0.00
       SIDE 4        0.70

       SIDE 1:  Q RATIO IS EQUAL TO 0.0

                STEEL OR TITANIUM - FASTENER BENDING IS ACCEPTABLE.
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       SIDE 2:  Q RATIO IS EQUAL TO OR LESS THAN 2.0

                ALUMINUM - FASTENER BENDING IS ACCEPTABLE.

       SIDE 3:  Q RATIO IS EQUAL TO 0.0

                STEEL OR TITANIUM - FASTENER BENDING IS ACCEPTABLE.

       SIDE 4:  Q RATIO IS EQUAL TO OR LESS THAN 2.0

                ALUMINUM - FASTENER BENDING IS ACCEPTABLE.

If the repair doubler or the fastener joints for any of the sides had been inadequate (MS < 0) or
only marginally adequate (MS = 0), it would be necessary to return to the Fastener
Arrangement dialog window to modify the fasteners and/or doublers.

8.1.4.2  Damage Tolerance Analysis

If the repair is statically adequate, the damage tolerance analysis (DTA) can be run.

Selecting the Create/View DTA Input File menu item automatically invokes the Damage
Tolerance Options dialog window. For this example, select the Simplified Method for Crack
Growth , the Single through crack emanating from a center hole option, and an Operating
Pressure Differential of 8.6 psi.
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After closing the dialog window by selecting the OK  button, select the Load/Stress Spectrum
Information  window from the Load Stress Spectrum Inputs menu item on the Damage
Tolerance submenu of the Analysis Menu. For this example, select the Generic Wide-Body
Load Spectrum. RAPID will automatically convert the stress spectrum at the repair location to
an equivalent, constant amplitude stress cycle for use in the simplified analysis.

Clicking the OK  button starts the stress spectrum generation program after displaying the
following warning.
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If the selected load spectrum has not previously been generated then the following message will
be displayed.

In this occurs, then press the OK  button, cancel the Load/Stress Spectrum Information dialog
window, select the Generate Load Spectra menu item from the Program Setup submenu of
the Tools menu, and generate the desired spectrum.  Then, return to the Load/Stress Spectrum
Information  dialog window and continue.

Listed below is the input to the DTA module that may be displayed after the stress spectra are
generated:

2
REPAIR CONFIGURATION TYPE (1 External Doubler) - Side 2 - for Longitudinal Crack direction
            3
      SKIN: Mat. Type
          2024-T3 Clad Sheet
          Mat.Type, Thickness, Modulus(ksi), C,    P,   Kc(ksi*sqrt(in)),Yield S(ksi),FTU
            2     0.063     10500    9.01566e-10     3.68842     152.4        45        62
          EDSX, EDSY
             0.5     0.5
CUTOUT  : X Direct., Y Direct.
                18          8
EXT DBL1: Mat. Type
           2024-T3 Clad Sheet
          Mat.Type, Thickness, Modulus(ksi), C,    P,   Kc(ksi*sqrt(in)),Yield S(ksi)
            2     0.071     10500    9.01566e-10     3.68842     152.4        45
PITCH   : X Direct., Y Direct.
                 1           1
FSTNR   : Max # In Col
             4
          Material, Hole Diameter  *(1-AL, 2-TI, 3-Steel)
             1     0.19100
             1     0.19100
             1     0.19100
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             1     0.19100
          Max # In Row, Crit #, Crit #, Overlap, L2R
              24          12      24       0      0
STIFF   : Max #, POS,   CSA, Yng.Mod.,  HPit
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
          Dblr Id
           1
PROXMTY : Flag,Delta X,Delta Y,IQS, Sub.X, Sub.Y,IQP, Prx.X, Prx.Y, EDPX, EDPY
            0    0.000   0.000   1  24.000  16.000   1   0.000   0.000 0.500 0.500
FUSELAGE: Eqv.Stress, Press. Diff, Radius
            17.0000       8.6     120.000
CRK GRW : RunType,Crk.Scnr,Vsl.Meth,Method,Rtd.Flag,TipA,TipB,ICL,KBFLG
            2         1       0        1      0    0.050 0.000   0    0
REPAIR CONFIGURATION TYPE (1 External Doubler) - Side 3 - for Circumferential Crack direction
            3
      SKIN: Mat. Type
          2024-T3 Clad Sheet
          Mat.Type, Thickness, Modulus(ksi), C,    P,   Kc(ksi*sqrt(in)),Yield S(ksi),FTU
            1     0.063     10500    6.76125e-10      3.7198     152.4        45        62
          EDSX, EDSY
             0.5     0.5
CUTOUT  : X Direct., Y Direct.
                 8         18
EXT DBL1: Mat. Type
           2024-T3 Clad Sheet
          Mat.Type, Thickness, Modulus(ksi), C,    P,   Kc(ksi*sqrt(in)),Yield S(ksi)
            1     0.071     10500    6.76125e-10      3.7198     152.4        45
PITCH   : X Direct., Y Direct.
                 1           1
FSTNR   : Max # In Col
             3
          Material, Hole Diameter  *(1-AL, 2-TI, 3-Steel)
             3     0.19000
             3     0.19000
             3     0.19000
          Max # In Row, Crit #, Crit #, Overlap, L2R
              16           9      16       0      0
STIFF   : Max #, POS,   CSA, Yng.Mod.,  HPit
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
          Dblr Id
           1
PROXMTY : Flag,Delta X,Delta Y,IQS, Sub.X, Sub.Y,IQP, Prx.X, Prx.Y, EDPX, EDPY
            0    0.000   0.000   1  16.000  24.000   1   0.000   0.000 0.500 0.500
FUSELAGE: Eqv.Stress, Press. Diff, Radius
             8.0000       8.6     120.000
CRK GRW : RunType,Crk.Scnr,Vsl.Meth,Method,Rtd.Flag,TipA,TipB,ICL,KBFLG
            2         1       0        1      0    0.050 0.000   1    0

The damage tolerance analysis is then executed by selecting the Run Damage Tolerance
Analysis menu item located in the Damage Tolerance section of the Analysis pull-down menu.
The following shows a condensed version of the textual output produced by the DTA module
and displayed by selecting the Tabular DTA Results menu item in the Damage Tolerance
section of the Analysis pull-down menu:
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DAMAGE TOLERANCE ANALYSIS RESULTS OF THE REPAIR
-----------------------------------------------

THE FOLLOWING 2 SETS OF OUTPUT ARE FOR THE LONGITUDINAL CRACKS OF SIDE 2:

     *****   CENTER FASTENER   *****

     FASTENER LOAD =   17.17707 POUNDS (BASED ON 1000.0 PSI FAR FIELD REFERENCE STRESS)

     (A) CRACK GROWTH LIFE AND RESIDUAL STRENGTH:

         EDGE-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
            0.05000                0            45.00000
            0.12590             7862            45.00000
            0.20180            15182            45.00000
            0.27770            21532            45.00000
            0.35360            26872            45.00000
            0.42950            31331            45.00000
            0.50540            35050            45.00000
            0.58130            38126            45.00000
            0.65720            40552            45.00000
            0.73310            42257            45.00000
            0.80900            43170            45.00000

          TIP-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
            1.19100            43170            45.00000
            1.40747            44320            45.00000
            1.42798            44402            45.00000
            1.45198            44492            45.00000
            1.47841            44591            45.00000

.

. (etc…)

.
           17.80900            50801            20.52188
           18.19100            50801            20.52188
           18.21032            50801            20.11429

     (B) NDI INSPECTION INTERVAL:

         AFTER REPAIR INSTALLATION, FIRST INSPECTION IS AT    25400 FLTS.

          DETECTABLE           INSPECTION
         CRACK LENGTH           INTERVAL
           (INCHES)             (FLIGHTS)
         ------------          ----------
            0.05000              25400
            0.10000              22811
            0.15000              20307
            0.20000              17896
            0.25000              15793

.

. (etc…)

.
           11.86189                104
           11.91189                102
           11.96189                100

  NOTE:  FOR DEFINITION AND SKETCH OF THE DETECTABLE
         CRACK LENGTHS, PLEASE SEE THE ANALYSIS MODULE
         HELP FILE.

     *****   RIGHT CORNER FASTENER   *****

     FASTENER LOAD =   22.12082 POUNDS (BASED ON 1000.0 PSI FAR FIELD REFERENCE STRESS)
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     (A) CRACK GROWTH LIFE AND RESIDUAL STRENGTH:

         EDGE-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
            0.05000                0            45.00000
            0.12590             3104            45.00000
            0.20180             5995            45.00000
            0.27770             8503            45.00000
            0.35360            10612            45.00000
            0.42950            12373            45.00000
            0.50540            13843            45.00000
            0.58130            15059            45.00000
            0.65720            16018            45.00000
            0.73310            16691            45.00000
            0.80900            17052            45.00000

          TIP-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
            1.19100            17052            45.00000
            1.49024            17675            45.00000
            1.51853            17721            45.00000
            1.55172            17771            45.00000
            1.58583            17825            45.00000

.

. (etc…)

.
           18.96424            21070            20.83612
           19.13749            21072            20.42561
           19.27160            21073            20.11429

     (B) NDI INSPECTION INTERVAL:

         AFTER REPAIR INSTALLATION, FIRST INSPECTION IS AT    10536 FLTS.

          DETECTABLE           INSPECTION
         CRACK LENGTH           INTERVAL
           (INCHES)             (FLIGHTS)
         ------------          ----------
            0.05000              10536
            0.10000               9514
            0.15000               8525
            0.20000               7573
            0.25000               6743

.

. (etc…)

.
           12.52449                104
           12.57449                102
           12.62449                100

  NOTE:  FOR DEFINITION AND SKETCH OF THE DETECTABLE
         CRACK LENGTHS, PLEASE SEE THE ANALYSIS MODULE
         HELP FILE.

THE FOLLOWING 2 SETS OF OUTPUT ARE FOR THE CIRCUMFERENTIAL CRACKS OF SIDE 3:

     *****   CENTER FASTENER   *****

     FASTENER LOAD =   20.84483 POUNDS (BASED ON 1000.0 PSI FAR FIELD REFERENCE STRESS)

     (A) CRACK GROWTH LIFE AND RESIDUAL STRENGTH:

         EDGE-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
            0.05000                0            45.00000
            0.12600           149606            45.00000
            0.20200           296284            45.00000
            0.20414           300000            45.00000
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     *****   BOTTOM CORNER FASTENER   *****

     FASTENER LOAD =   23.06234 POUNDS (BASED ON 1000.0 PSI FAR FIELD REFERENCE STRESS)

     (A) CRACK GROWTH LIFE AND RESIDUAL STRENGTH:

         EDGE-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
            0.05000                0            45.00000
            0.12600            59745            45.00000
            0.20200           115796            45.00000
            0.27800           164608            45.00000
            0.35400           205717            45.00000
            0.43000           240066            45.00000
            0.50600           268730            45.00000
            0.58200           292424            45.00000
            0.61282           300000            45.00000

These results can be displayed graphically as Residual Strength vs. Crack Length, Crack
Length vs. Number of Flights, and Inspection Interval vs. Detectable Crack Length plots.
Each of these plots, which are shown below, is generated for longitudinal cracks in the center
and corner fasteners above the cutout and for circumferential cracks in the center and corner
fasteners to the right of the cutout. The plots can be selected from the Damage Tolerance
section of the Analysis pull-down menu in the main RAPID MDI.
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Selecting the plot for side three will display the following informational message to indicate that
the plot is not available because the critical crack length was not reached within the program
limit of 300,000 flights.



103



104

Selecting the plot for side three will display the following informational message to indicate that
the plot is not available because the critical crack length was not reached within the program
limit of 300,000 flights.

8.1.5  View and Print the Report

To view the report, select Report from the Analysis menu.

While the report is displayed, it may be printed by selecting Print  from the File menu.

This will invoke the Report Print Options dialog window, through which the user may choose
which components of the report to print.
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8.1.6  Save the Repair Model

This completes the example problem. To save the model, select either the Save or Save As menu
item from the File pull down menu. Once saved, the model can be opened and modified in a
subsequent RAPID session by selecting the file open button on the button bar or the Open menu
item in the File pull-down menu.
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8.2  Longitudinal Butt Joi nt Example

The following is an example of a rectangular cutout with a single external doubler repair over a
longitudinal butt joint.  The cutout is 8 inches high by 5 inches wide and is centered between
frames and longerons spaced on 20-inch centers.  The doubler size and fastener locations are
automatically determined by the default pitch and edge distance settings, together with the
selected number of fastener rows per side.  The layout and materials are shown in the following
figure.

Longeron

Frame

Doubler
Skin Cutout

Edge distance = 0.5″

Splice:
2024-T3 Clad Sheet
Thickness = 0.040″

Doubler:
2024-T3 Clad Sheet
Thickness = 0.063″

Fasteners:
NAS1097-E6
Pitch = 1.0″

Splice

20.0”

20.0″

Lower
Skin

Upper
Skin

8.0″6.0″ 14.0″

5.0″

11.0″

Skin:
2024-T3 Clad Sheet
Thickness = 0.050″

8.2.1  Create the New R APID Model

The first step is to start the RAPID program from the Windows Program Manager.  Once
launched, RAPID will display its main MDI window, as shown below.  All of the dialog
windows shown in this example appear as subwindows within the RAPID MDI window.  To
begin a new repair, select New from the File menu.
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The Setup dialog window can be selected from the Tools --> Program Setup --> File
Locations pull-down menu and is shown below.  There is no need to use the Setup dialog
window unless there is a need to change the default RAPID configuration.  The fastener pitch
and edge distances will be used by the Fastener Arrangement dialog window to automatically
determine the number and arrangement of the fasteners in the repair.  The defaults can be
changed here or, on a model to model basis, within the Fastener Arrangement dialog window
which will be used later.  If any of the values are changed, then the OK  button must be selected
for the values to be written to the RAPID.INI file, which stores the RAPID defaults.  In this
example, we will retain the defaults and simply close the dialog window by clicking on the
Cancel button.
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The first dialog window in which data will be input is the Aircraft/General Information
window, shown below with example input data already entered.  This window can be selected
either from the MDI button bar or from the General pull-down menu.  Once the data is entered,
the OK  button must be selected to store the data in the current model and close the dialog
window.

8.2.2  Define Repair Type and Location

Next, the repair type is selected from the Repair Type dialog window, as shown below.  This
dialog window can be selected either from the icon button bar or from the General pull-down



109

menu.  The Over/Near Butt Joint Repair Configuration Type is selected, along with Stiffener
Effects, in a Single - Longitudinal configuration.  The selection is saved and the dialog window
is closed by pressing the OK  button.

The Damage Location dialog window is invoked to enter the location of the damage on the
structure and is shown below.  This window can be selected either from the icon button bar or
from the General pull-down menu.

The distances entered on this dialog window refer to regions of the aircraft as depicted in the
zone diagram which can be displayed by selecting the Zones button and which is shown in the
following figure.  As with all of the other dialogs with OK  buttons, remember to save the data
and close the dialog by pressing the OK  button after completing the entries.
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8.2.3  Draw the Repair

After entering the damage location information, the Grid Scale dialog window will be
automatically displayed to set the drawing scale to accommodate the size of the planned repair.
The grid scale can be reset at any other time by selecting the Grid scale menu item from the
Tools pull-down menu.

For the depicted 640 x 480 screen resolution, a grid scale of 4 inches per grid will result in a
workspace of adequate size to draw the largest included object, the repair boundary which is 20
inches wide by 20 inches high.
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8.2.3.1  Define the Repair Boundary

The repair boundary tool is used to draw the region defined by the two frames and two longerons
which are just outside of the region of the repair, as defined by the doubler.

After selecting the repair boundary tool from the tool bar, the repair boundary is drawn by
clicking the left mouse button on one corner of the repair boundary and then, while continuing to
depress the left mouse button, dragging the mouse to the opposite corner of the repair boundary
and then releasing the left mouse button.  The changing size of the repair boundary is displayed
in the upper left of the display as the area is drawn.

When the left mouse button is released, the Repair Boundary Information  dialog window is
automatically displayed to input the frame and longeron labels and the Number of Fasteners
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and the Cross-Sectional Area and to fine-tune the Overall Distances in the Longitudinal  and
Circumferential  directions.  Remember to enter data for each of the four stiffeners by clicking
on each of the four Stiffener buttons in turn.

8.2.3.2  Define Skin Properties     

Selecting Skin Properties from the Design menu or selecting the Skin Properties icon on the
button bar invokes the Skin Properties dialog window.  Because the repair is over a butt joint,
the existing geometry of the joint must also be entered.

For the two skin layers and the splice layer listed in the Object combo-box in the Properties
section, select the Material  and Thickness.  In the Geometry section, enter the dimensions of
the splice and the existing fastener geometry.
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Pressing OK  updates the Drawing window to represent the local skin areas as rectangles
extending just beyond the repair boundary frames and longerons.  The existing butt joint and
fasteners are also displayed.
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8.2.3.3  Draw the Cutout

Next, the cutout is defined by selecting the cutout tool on the tool bar.

The cutout is drawn by clicking the left mouse button on one corner of the cutout and then, while
continuing to depress the left mouse button, dragging the mouse to the opposite corner of the
cutout and then releasing the mouse button.  The size and location of the centroid with respect to
the left most frame and bottom longeron are displayed in the upper left of the display.

When the left mouse button is released, the Cutout Geometry window is automatically
displayed to allow manual correction of the dimensions.
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8.2.3.4  Create the Fasteners

The fastener arrangement is then defined by selecting the Fastener Properties tool from the
button bar or from the Design menu.

This invokes the Fastener Global Properties dialog window.  This dialog window is used to
change the default pitch and edge distances and to enter the number of fastener rows per side of
each doubler.  Because this information is used by RAPID to automatically size the doublers, the
material and thickness of each doubler should also be entered.  For the current example, only one
external doubler is included.
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The one fastener type in the model should now be entered by pressing the Fastener Types
Define button to display the Fastener Properties input screen.  Enter 1 for the No. of Fastener
Types and then enter the Style and Diameter for that Type No.

When the OK  button is selected in the Fastener Global Properties screen, the fasteners and
doubler are automatically generated and displayed in the workspace.
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8.2.4  Run the Analyses

The analyses can then be run and the results viewed by using the Analysis pull-down menu.

8.2.4.1  Static Analysis

Listed below is the input to the Static module as displayed by the Create/View Static Input File
menu item in the Static Analysis section of the Analysis pull-down menu:

REPAIR CONFIGURATION TYPE (Single Butt Joint)
            4
SKIN/DAMAGE : Number of Layers
              1
         SKIN : Mat.Type
               2024-T3 CLAD SHEET
              # of Sides, Thickness, FTU (ksi), Modulus (ksi)
                  4      0.05        60     10500
SIDE 1     : LENGTH, FSU
                    8    37
              MAX# OF FASTENER TYPES
               1
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             42            1.139    0.191
              MAX# OF ROWS
               3
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              NUMBER OF FASTENERS PER ROW
                14
                14
                14
SIDE 2     : LENGTH, FSU
                    5    37
              MAX# OF FASTENER TYPES
               1
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             33            1.139    0.191
              MAX# OF ROWS
               3
              NUMBER OF FASTENERS PER ROW
                11
                11
                11
SIDE 3     : LENGTH, FSU
                    8    37
              MAX# OF FASTENER TYPES
               1
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             42            1.139    0.191
              MAX# OF ROWS
               3
              NUMBER OF FASTENERS PER ROW
                14
                14
                14
SIDE 4     : LENGTH, FSU
                    5    37
              MAX# OF FASTENER TYPES
               1
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             33            1.139    0.191
              MAX# OF ROWS
               3
              NUMBER OF FASTENERS PER ROW
                11
                11
                11
REPAIR       : Number of Layers
              1
EXT DBL1   : Mat.Type
               2024-T3 CLAD SHEET
              # of Sides, Thickness, FTU (ksi), Modulus (ksi)
                  4     0.063        62     10500
SIDE 1     : LENGTH, FSU
                   14    38
              MAX# OF FASTENER TYPES
               1
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             42            1.005    0.191
              MAX# OF ROWS
               3
              NUMBER OF FASTENERS PER ROW
                14
                14
                14
SIDE 2     : LENGTH, FSU
                   11    38
              MAX# OF FASTENER TYPES
               1
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             33            1.005    0.191
              MAX# OF ROWS
               3
              NUMBER OF FASTENERS PER ROW
                11
                11
                11
SIDE 3     : LENGTH, FSU
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                   14    38
              MAX# OF FASTENER TYPES
               1
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             42            1.005    0.191
              MAX# OF ROWS
               3
              NUMBER OF FASTENERS PER ROW
                14
                14
                14
SIDE 4     : LENGTH, FSU
                   11    38
              MAX# OF FASTENER TYPES
               1
              FASTENER TYPE, AMOUNT, JOINT ALLOWABLE, DIAMETER
               1             33            1.005    0.191
              MAX# OF ROWS
               3
              NUMBER OF FASTENERS PER ROW
                11
                11
                11
PITCH   : Circumferential, Longitudinal
               1.0000        1.0000
BENDING : Q Ratio
           2.0

The static analysis is then executed by selecting the Run Static Analysis menu item located in
the Static Analysis section of the Analysis pull-down menu.  When the analysis is complete,
RAPID displays the Static Analysis Results Summary.

The following shows the textual output produced by the static analysis and displayed by
selecting the Tabular Static Results menu item in the Static Analysis section of the Analysis
pull-down.  Note that the margins of safety for the doublers and the fasteners are all positive,
indicating that the chosen design is statically adequate.

                        STATIC ANALYSIS RESULTS OF THE REPAIR
                        -------------------------------------

 (A) MARGINS OF SAFETY:

     *** REPAIR DOUBLERS ***

           0.30

       MARGIN OF SAFETY IS POSITIVE.
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       THE REPAIR DOUBLERS ARE STATICALLY ADEQUATE.

     *** FASTENER JOINTS ***

                LOAD LOST        LOAD RESTORED        MARGIN OF SAFETY
                  (LBS)              (LBS)            (NONDIMENSIONAL)
                ---------        -------------        ----------------

       SIDE 1     24000            42210                0.76
       SIDE 2     15000            33165                1.21
       SIDE 3     24000            42210                0.76
       SIDE 4     15000            33165                1.21

       SIDE 1:  MARGIN OF SAFETY IS POSITIVE.

                THE FASTENER JOINTS ARE STATICALLY ADEQUATE.

       SIDE 2:  MARGIN OF SAFETY IS POSITIVE.

                THE FASTENER JOINTS ARE STATICALLY ADEQUATE.

       SIDE 3:  MARGIN OF SAFETY IS POSITIVE.

                THE FASTENER JOINTS ARE STATICALLY ADEQUATE.

       SIDE 4:  MARGIN OF SAFETY IS POSITIVE.

                THE FASTENER JOINTS ARE STATICALLY ADEQUATE.

 (B) SHEAR STRENGTHS:

                DOUBLER(S)           SKIN             MARGIN OF SAFETY
                   (LBS)             (LBS)            (NONDIMENSIONAL)
                ----------        ----------          ----------------

       SIDE 1      2394              1850                0.29
       SIDE 2      2394              1850                0.29
       SIDE 3      2394              1850                0.29
       SIDE 4      2394              1850                0.29

       SIDE 1:  MARGIN OF SAFETY IS POSITIVE.

                THE SHEAR STRENGTH OF THE REPAIR IS STATICALLY ADEQUATE.

       SIDE 2:  MARGIN OF SAFETY IS POSITIVE.

                THE SHEAR STRENGTH OF THE REPAIR IS STATICALLY ADEQUATE.

       SIDE 3:  MARGIN OF SAFETY IS POSITIVE.

                THE SHEAR STRENGTH OF THE REPAIR IS STATICALLY ADEQUATE.

       SIDE 4:  MARGIN OF SAFETY IS POSITIVE.

                THE SHEAR STRENGTH OF THE REPAIR IS STATICALLY ADEQUATE.

 (C) STIFFNESS:

                DOUBLER(S)           SKIN             STIFFNESS RATIO
                 (LBS/IN)          (LBS/IN)           (NONDIMENSIONAL)
                ----------        ----------          ----------------

       SIDE 1    661500            525000                1.26
       SIDE 2    661500            525000                1.26
       SIDE 3    661500            525000                1.26
       SIDE 4    661500            525000                1.26
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       SIDE 1:  STIFFNESS RATIO IS BETWEEN 1 AND 1.5

                REPAIR STIFFNESS IS ACCEPTABLE.

       SIDE 2:  STIFFNESS RATIO IS BETWEEN 1 AND 1.5

                REPAIR STIFFNESS IS ACCEPTABLE.

       SIDE 3:  STIFFNESS RATIO IS BETWEEN 1 AND 1.5

                REPAIR STIFFNESS IS ACCEPTABLE.

       SIDE 4:  STIFFNESS RATIO IS BETWEEN 1 AND 1.5

                REPAIR STIFFNESS IS ACCEPTABLE.

 (D) FASTENER BENDING:

                     Q RATIO
                 (NONDIMENSIONAL)
                 ----------------

       SIDE 1        0.59
       SIDE 2        0.59
       SIDE 3        0.59
       SIDE 4        0.59

       SIDE 1:  Q RATIO IS EQUAL TO OR LESS THAN 2.0

                ALUMINUM - FASTENER BENDING IS ACCEPTABLE.

       SIDE 2:  Q RATIO IS EQUAL TO OR LESS THAN 2.0

                ALUMINUM - FASTENER BENDING IS ACCEPTABLE.

       SIDE 3:  Q RATIO IS EQUAL TO OR LESS THAN 2.0

                ALUMINUM - FASTENER BENDING IS ACCEPTABLE.

       SIDE 4:  Q RATIO IS EQUAL TO OR LESS THAN 2.0

                ALUMINUM - FASTENER BENDING IS ACCEPTABLE.

If the repair doubler or the fastener joints for any of the sides had been inadequate (MS < 0) or
only marginally adequate (MS = 0), it would be necessary to return to the Fastener
Arrangement dialog window to modify the fasteners and/or doublers.

8.2.4.2  Damage Tolerance Analysis

Now that it has been determined that the repair is statically adequate, the damage tolerance
analysis (DTA) can be run.
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Select the DTA Options dialog window. For this example, select the Simplified Method for
Crack Growth , the Single through crack center hole Option, and an Operating Pressure
Differential  of 8.6 psi.

Close the window by selecting the OK  button, then select the Create/View DTA Input File
menu item which will automatically invoke the Load/Stress Spectrum Information dialog
window. For this example, select the Generic Narrow-Body Load Spectrum.
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Clicking the OK  button starts the stress spectrum generation program after displaying the
following warning.

If the selected load spectrum has not previously been generated, then the following message will
be displayed.



125

In this occurs, then press the OK  button, cancel the Load/Stress Spectrum Information dialog
window, select the Generate Load Spectra menu item from the Program Setup submenu of
the Tools menu, and generate the desired spectrum. Then, return to the Load/Stress Spectrum
Information  dialog and continue.

Listed below is the input to the DTA module which is displayed after the stress spectra are
generated:

4
REPAIR CONFIGURATION TYPE (Single Butt Joint) - Side 1 - for Circumferential Crack direction
            4
      SKIN: Mat. Type
          2024-T3 Clad Sheet
          Mat.Type, Thickness, Modulus(ksi), C,    P,   Kc(ksi*sqrt(in)),Yield S(ksi),FTU
            1      0.05     10500    6.76125e-10      3.7198       153        44        60
          EDSX, EDSY
             0.5     0.5
CUTOUT  : X Direct., Y Direct.
                 8          5
EXT DBL1: Mat. Type
           2024-T3 Clad Sheet
          Mat.Type, Thickness, Modulus(ksi), C,    P,   Kc(ksi*sqrt(in)),Yield S(ksi)
            1     0.063     10500    6.76125e-10      3.7198     152.4        45
PITCH   : X Direct., Y Direct.
                 1           1
FSTNR   : Max # In Col
             3
          Material, Hole Diameter  *(1-AL, 2-TI, 3-Steel)
             1     0.19100
             1     0.19100
             1     0.19100
          Max # In Row, Crit #, Crit #, Overlap, L2R
              14           8       0       0      0
STIFF   : Max #, POS,   CSA, Yng.Mod.,  HPit
            1   3.000 0.500 10500.000 1.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            2   3.000 0.500 10500.000 1.0000       23.000 0.500 10500.000 1.0000
          Dblr Id
           1
PROXMTY : Flag,Delta X,Delta Y,IQS, Sub.X, Sub.Y,IQP, Prx.X, Prx.Y, EDPX, EDPY
            0    0.000   0.000   1  14.000  11.000   1   0.000   0.000 0.500 0.500
FUSELAGE: Eqv.Stress, Press. Diff, Radius
            10.0120       8.6     120.000
CRK GRW : RunType,Crk.Scnr,Vsl.Meth,Method,Rtd.Flag,TipA,TipB,ICL,KBFLG
            1         4       0        1      0    0.050 0.000   1    0
REPAIR CONFIGURATION TYPE (1 External Doubler) - Side 2 - for Longitudinal Crack direction
            3
      SKIN: Mat. Type
          2024-T3 Clad Sheet
          Mat.Type, Thickness, Modulus(ksi), C,    P,   Kc(ksi*sqrt(in)),Yield S(ksi),FTU
            2      0.05     10500    9.01566e-10     3.68842       153        44        60
          EDSX, EDSY
             0.5     0.5
CUTOUT  : X Direct., Y Direct.
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                 5          8
EXT DBL1: Mat. Type
           2024-T3 Clad Sheet
          Mat.Type, Thickness, Modulus(ksi), C,    P,   Kc(ksi*sqrt(in)),Yield S(ksi)
            2     0.063     10500    9.01566e-10     3.68842     152.4        45
PITCH   : X Direct., Y Direct.
                 1           1
FSTNR   : Max # In Col
             3
          Material, Hole Diameter  *(1-AL, 2-TI, 3-Steel)
             1     0.19100
             1     0.19100
             1     0.19100
          Max # In Row, Crit #, Crit #, Overlap, L2R
              11           6      11       0      0
STIFF   : Max #, POS,   CSA, Yng.Mod.,  HPit
            1   4.500 0.500 10500.000 1.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            2   4.500 0.500 10500.000 1.0000       24.500 0.500 10500.000 1.0000
          Dblr Id
           1
PROXMTY : Flag,Delta X,Delta Y,IQS, Sub.X, Sub.Y,IQP, Prx.X, Prx.Y, EDPX, EDPY
            0    0.000   0.000   1  11.000  14.000   1   0.000   0.000 0.500 0.500
FUSELAGE: Eqv.Stress, Press. Diff, Radius
            18.6360       8.6     120.000
CRK GRW : RunType,Crk.Scnr,Vsl.Meth,Method,Rtd.Flag,TipA,TipB,ICL,KBFLG
            3         1       0        1      0    0.050 0.000   0    0
REPAIR CONFIGURATION TYPE (Single Butt Joint) - Side 3 - for Circumferential Crack direction
            4
      SKIN: Mat. Type
          2024-T3 Clad Sheet
          Mat.Type, Thickness, Modulus(ksi), C,    P,   Kc(ksi*sqrt(in)),Yield S(ksi),FTU
            1      0.05     10500    6.76125e-10      3.7198       153        44        60
          EDSX, EDSY
             0.5     0.5
CUTOUT  : X Direct., Y Direct.
                 8          5
EXT DBL1: Mat. Type
           2024-T3 Clad Sheet
          Mat.Type, Thickness, Modulus(ksi), C,    P,   Kc(ksi*sqrt(in)),Yield S(ksi)
            1     0.063     10500    6.76125e-10      3.7198     152.4        45
PITCH   : X Direct., Y Direct.
                 1           1
FSTNR   : Max # In Col
             3
          Material, Hole Diameter  *(1-AL, 2-TI, 3-Steel)
             1     0.19100
             1     0.19100
             1     0.19100
          Max # In Row, Crit #, Crit #, Overlap, L2R
              14           8       0       0      0
STIFF   : Max #, POS,   CSA, Yng.Mod.,  HPit
            1   3.000 0.500 10500.000 1.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            2   3.000 0.500 10500.000 1.0000       23.000 0.500 10500.000 1.0000
          Dblr Id
           1
PROXMTY : Flag,Delta X,Delta Y,IQS, Sub.X, Sub.Y,IQP, Prx.X, Prx.Y, EDPX, EDPY
            0    0.000   0.000   1  14.000  11.000   1   0.000   0.000 0.500 0.500
FUSELAGE: Eqv.Stress, Press. Diff, Radius
            10.0120       8.6     120.000
CRK GRW : RunType,Crk.Scnr,Vsl.Meth,Method,Rtd.Flag,TipA,TipB,ICL,KBFLG
            1         4       0        1      0    0.050 0.000   1    0
REPAIR CONFIGURATION TYPE (1 External Doubler) - Side 4 - for Longitudinal Crack direction
            3
      SKIN: Mat. Type
          2024-T3 Clad Sheet
          Mat.Type, Thickness, Modulus(ksi), C,    P,   Kc(ksi*sqrt(in)),Yield S(ksi),FTU
            2      0.05     10500    9.01566e-10     3.68842       153        44        60
          EDSX, EDSY
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             0.5     0.5
CUTOUT  : X Direct., Y Direct.
                 5          8
EXT DBL1: Mat. Type
           2024-T3 Clad Sheet
          Mat.Type, Thickness, Modulus(ksi), C,    P,   Kc(ksi*sqrt(in)),Yield S(ksi)
            2     0.063     10500    9.01566e-10     3.68842     152.4        45
PITCH   : X Direct., Y Direct.
                 1           1
FSTNR   : Max # In Col
             3
          Material, Hole Diameter  *(1-AL, 2-TI, 3-Steel)
             1     0.19100
             1     0.19100
             1     0.19100
          Max # In Row, Crit #, Crit #, Overlap, L2R
              11           6      11       0      0
STIFF   : Max #, POS,   CSA, Yng.Mod.,  HPit
            1   4.500 0.500 10500.000 1.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            0   0.000 0.000     0.000 0.0000
            2   4.500 0.500 10500.000 1.0000       24.500 0.500 10500.000 1.0000
          Dblr Id
           1
PROXMTY : Flag,Delta X,Delta Y,IQS, Sub.X, Sub.Y,IQP, Prx.X, Prx.Y, EDPX, EDPY
            0    0.000   0.000   1  11.000  14.000   1   0.000   0.000 0.500 0.500
FUSELAGE: Eqv.Stress, Press. Diff, Radius
            18.6360       8.6     120.000
CRK GRW : RunType,Crk.Scnr,Vsl.Meth,Method,Rtd.Flag,TipA,TipB,ICL,KBFLG
            3         1       0        1      0    0.050 0.000   0    0

The damage tolerance analysis is then executed by selecting the Run Damage Tolerance
Analysis menu item located in the Damage Tolerance section of the Analysis pull-down menu.
The following shows the textual output produced by the DTA module and displayed by selecting
the Tabular DTA Results menu item in the Damage Tolerance section of the Analysis pull-
down menu:

DAMAGE TOLERANCE ANALYSIS RESULTS OF THE REPAIR
-----------------------------------------------

THE FOLLOWING 1 SET OF OUTPUT IS FOR THE CIRCUMFERENTIAL CRACK OF SIDE 1:

     *****   BUTT JOINT FASTENER   *****

     FASTENER LOAD =   16.73764 POUNDS (BASED ON 1000.0 PSI FAR FIELD REFERENCE STRESS)

     (A) CRACK GROWTH LIFE AND RESIDUAL STRENGTH:

         EDGE-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
            0.05000                0            44.00000
            0.08545            19513            44.00000
            0.12090            38236            44.00000
            0.15635            56193            44.00000
            0.19180            73489            44.00000
            0.22725            89240            44.00000
            0.26270           102306            44.00000
            0.29815           112438            44.00000
            0.33360           119651            44.00000
            0.36905           123712            44.00000
            0.40450           124900            39.65282
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          TIP-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
            0.59550           124900            39.65282
            0.60050           124900            44.00000
            0.61122           126188            44.00000
            0.62194           126712            44.00000
            0.63266           127148            44.00000
            0.64338           127516            44.00000
            0.65410           127859            44.00000
            0.92210           136003            44.00000
            1.08290           140030            44.00000
            1.24370           142932            44.00000
            1.40450           144575            44.00000
            1.59550           144575            44.00000
            1.60050           144575            44.00000
            1.60521           144585            44.00000
            1.60922           144593            35.20000

     (B) NDI INSPECTION INTERVAL:

         AFTER REPAIR INSTALLATION, FIRST INSPECTION IS AT    72296 FLTS.

          DETECTABLE           INSPECTION
         CRACK LENGTH           INTERVAL
           (INCHES)             (FLIGHTS)
         ------------          ----------
            0.05000              72296
            0.10000              58697
            0.15000              45808
            0.20000              33730
            0.25000              23484

.

. (etc…)

.
            1.24550                821
            1.29550                566
            1.34550                310

  NOTE:  FOR DEFINITION AND SKETCH OF THE DETECTABLE
         CRACK LENGTHS, PLEASE SEE THE ANALYSIS MODULE
         HELP FILE.

THE FOLLOWING 3 SETS OF OUTPUT ARE FOR THE LONGITUDINAL CRACKS OF SIDE 2:

     *****   CENTER FASTENER   *****

     FASTENER LOAD =   16.73764 POUNDS (BASED ON 1000.0 PSI FAR FIELD REFERENCE STRESS)

     (A) CRACK GROWTH LIFE AND RESIDUAL STRENGTH:

         EDGE-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
            0.05000                0            44.00000
            0.27770            16728            44.00000
            0.35360            21565            44.00000
            0.42950            25852            44.00000
            0.50540            29636            44.00000
            0.58130            32935            44.00000
            0.65720            35675            44.00000
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            0.73310            37699            44.00000
            0.80900            38838            44.00000

          TIP-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
            1.19100            38838            44.00000
            1.28294            39572            44.00000
            1.29226            39616            44.00000
            1.30184            39663            44.00000
            1.31307            39714            44.00000

.

. (etc…)

.
           21.49009            48421            31.44543
           22.57077            48443            27.55699
           23.22652            48451            25.34400

     (B) NDI INSPECTION INTERVAL:

         AFTER REPAIR INSTALLATION, FIRST INSPECTION IS AT    24225 FLTS.

          DETECTABLE           INSPECTION
         CRACK LENGTH           INTERVAL
           (INCHES)             (FLIGHTS)
         ------------          ----------
            0.05000              24225
            0.10000              22389
            0.15000              20552
            0.20000              18715
            0.25000              16879

.

. (etc…)

.
           16.95961                102
           17.00961                101
           17.05961                100

  NOTE:  FOR DEFINITION AND SKETCH OF THE DETECTABLE
         CRACK LENGTHS, PLEASE SEE THE ANALYSIS MODULE
         HELP FILE.

     *****   RIGHT CORNER FASTENER   *****

     FASTENER LOAD =   19.28462 POUNDS (BASED ON 1000.0 PSI FAR FIELD REFERENCE STRESS)

     (A) CRACK GROWTH LIFE AND RESIDUAL STRENGTH:

         EDGE-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
            0.05000                0            44.00000
            0.20180             4522            44.00000
            0.27770             6584            44.00000
            0.35360             8409            44.00000
            0.42950            10010            44.00000
            0.50540            11411            44.00000
            0.58130            12625            44.00000
            0.65720            13628            44.00000
            0.73310            14367            44.00000
            0.80900            14782            44.00000
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          TIP-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
            1.19100            14782            44.00000
            1.94715            16792            44.00000
            2.02383            16950            44.00000
            2.10828            17117            44.00000
            2.20130            17290            44.00000

.

. (etc…)

.
           23.41755            23332            25.71043
           23.47536            23333            25.51849
           23.53229            23334            25.34400

     (B) NDI INSPECTION INTERVAL:

         AFTER REPAIR INSTALLATION, FIRST INSPECTION IS AT    11667 FLTS.

          DETECTABLE           INSPECTION
         CRACK LENGTH           INTERVAL
           (INCHES)             (FLIGHTS)
         ------------          ----------
            0.05000              11667
            0.10000              10922
            0.15000              10177
            0.20000               9432
            0.25000               8751

.

. (etc…)

.
           18.79217                104
           18.84217                102
           18.89217                100

  NOTE:  FOR DEFINITION AND SKETCH OF THE DETECTABLE
         CRACK LENGTHS, PLEASE SEE THE ANALYSIS MODULE
         HELP FILE.

     *****   LEFT CORNER FASTENER   *****

     FASTENER LOAD =   19.28462 POUNDS (BASED ON 1000.0 PSI FAR FIELD REFERENCE STRESS)

     (A) CRACK GROWTH LIFE AND RESIDUAL STRENGTH:

         EDGE-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
            0.05000                0            44.00000
            0.20180             4522            44.00000
            0.27770             6584            44.00000
            0.35360             8409            44.00000
            0.42950            10010            44.00000
            0.50540            11411            44.00000
            0.58130            12625            44.00000
            0.65720            13628            44.00000
            0.73310            14367            44.00000
            0.80900            14782            44.00000

          TIP-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
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         ------------      ------------      ------------
            1.19100            14782            44.00000
            1.93844            16803            44.00000
            1.97582            16885            44.00000
            2.01506            16969            44.00000
            2.05626            17056            44.00000

.

. (etc…)

.
           22.45173            23406            28.91621
           23.26524            23422            26.06554
           23.49343            23426            25.34400

     (B) NDI INSPECTION INTERVAL:

         AFTER REPAIR INSTALLATION, FIRST INSPECTION IS AT    11713 FLTS.

          DETECTABLE           INSPECTION
         CRACK LENGTH           INTERVAL
           (INCHES)             (FLIGHTS)
         ------------          ----------
            0.05000              11713
            0.10000              10968
            0.15000              10223
            0.20000               9478
            0.25000               8797

.

. (etc…)

.
           18.73218                104
           18.78218                103
           18.83217                101

  NOTE:  FOR DEFINITION AND SKETCH OF THE DETECTABLE
         CRACK LENGTHS, PLEASE SEE THE ANALYSIS MODULE
         HELP FILE.

THE FOLLOWING 1 SET OF OUTPUT IS FOR THE CIRCUMFERENTIAL CRACK OF SIDE 3:

     *****   BUTT JOINT FASTENER   *****

     FASTENER LOAD =   16.73764 POUNDS (BASED ON 1000.0 PSI FAR FIELD REFERENCE STRESS)

     (A) CRACK GROWTH LIFE AND RESIDUAL STRENGTH:

         EDGE-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
            0.05000                0            44.00000
            0.08545            19513            44.00000
            0.12090            38236            44.00000
            0.15635            56193            44.00000
            0.19180            73489            44.00000
            0.22725            89240            44.00000
            0.26270           102306            44.00000
            0.29815           112438            44.00000
            0.33360           119651            44.00000
            0.36905           123712            44.00000
            0.40450           124900            39.65282

          TIP-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
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         ------------      ------------      ------------
            0.59550           124900            39.65282
            0.60050           124900            44.00000
            0.61122           126188            44.00000
            0.62194           126712            44.00000
            0.63266           127148            44.00000
            0.64338           127516            44.00000
            0.65410           127859            44.00000
            0.92210           136003            44.00000
            1.08290           140030            44.00000
            1.24370           142932            44.00000
            1.40450           144575            44.00000
            1.59550           144575            44.00000
            1.60050           144575            44.00000
            1.60521           144585            44.00000
            1.60922           144593            35.20000

     (B) NDI INSPECTION INTERVAL:

         AFTER REPAIR INSTALLATION, FIRST INSPECTION IS AT    72296 FLTS.

          DETECTABLE           INSPECTION
         CRACK LENGTH           INTERVAL
           (INCHES)             (FLIGHTS)
         ------------          ----------
            0.05000              72296
            0.10000              58697
            0.15000              45808
            0.20000              33730
            0.25000              23484

.

. (etc…)

.
            1.24550                821
            1.29550                566
            1.34550                310

  NOTE:  FOR DEFINITION AND SKETCH OF THE DETECTABLE
         CRACK LENGTHS, PLEASE SEE THE ANALYSIS MODULE
         HELP FILE.

THE FOLLOWING 3 SETS OF OUTPUT ARE FOR THE LONGITUDINAL CRACKS OF SIDE 4:

     *****   CENTER FASTENER   *****

     FASTENER LOAD =   16.73764 POUNDS (BASED ON 1000.0 PSI FAR FIELD REFERENCE STRESS)

     (A) CRACK GROWTH LIFE AND RESIDUAL STRENGTH:

         EDGE-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
            0.05000                0            44.00000
            0.27770            16728            44.00000
            0.35360            21565            44.00000
            0.42950            25852            44.00000
            0.50540            29636            44.00000
            0.58130            32935            44.00000
            0.65720            35675            44.00000
            0.73310            37699            44.00000
            0.80900            38838            44.00000

          TIP-TO-TIP       CRACK GROWTH        RESIDUAL
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         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
            1.19100            38838            44.00000
            1.28294            39572            44.00000
            1.29226            39616            44.00000
            1.30184            39663            44.00000
            1.31307            39714            44.00000

.

. (etc…)

.
           21.49009            48421            31.44543
           22.57077            48443            27.55699
           23.22652            48451            25.34400

     (B) NDI INSPECTION INTERVAL:

         AFTER REPAIR INSTALLATION, FIRST INSPECTION IS AT    24225 FLTS.

          DETECTABLE           INSPECTION
         CRACK LENGTH           INTERVAL
           (INCHES)             (FLIGHTS)
         ------------          ----------
            0.05000              24225
            0.10000              22389
            0.15000              20552
            0.20000              18715
            0.25000              16879

.

. (etc…)

.
           16.95961                102
           17.00961                101
           17.05961                100

  NOTE:  FOR DEFINITION AND SKETCH OF THE DETECTABLE
         CRACK LENGTHS, PLEASE SEE THE ANALYSIS MODULE
         HELP FILE.

     *****   LEFT CORNER FASTENER   *****

     FASTENER LOAD =   19.28462 POUNDS (BASED ON 1000.0 PSI FAR FIELD REFERENCE STRESS)

     (A) CRACK GROWTH LIFE AND RESIDUAL STRENGTH:

         EDGE-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
            0.05000                0            44.00000
            0.20180             4522            44.00000
            0.27770             6584            44.00000
            0.35360             8409            44.00000
            0.42950            10010            44.00000
            0.50540            11411            44.00000
            0.58130            12625            44.00000
            0.65720            13628            44.00000
            0.73310            14367            44.00000
            0.80900            14782            44.00000

          TIP-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
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            1.19100            14782            44.00000
            1.94715            16792            44.00000
            2.02383            16950            44.00000
            2.10828            17117            44.00000
            2.20130            17290            44.00000

.

. (etc…)

.
           23.41755            23332            25.71043
           23.47536            23333            25.51849
           23.53229            23334            25.34400

     (B) NDI INSPECTION INTERVAL:

         AFTER REPAIR INSTALLATION, FIRST INSPECTION IS AT    11667 FLTS.

          DETECTABLE           INSPECTION
         CRACK LENGTH           INTERVAL
           (INCHES)             (FLIGHTS)
         ------------          ----------
            0.05000              11667
            0.10000              10922
            0.15000              10177
            0.20000               9432
            0.25000               8751

.

. (etc…)

.
           18.79217                104
           18.84217                102
           18.89217                100

  NOTE:  FOR DEFINITION AND SKETCH OF THE DETECTABLE
         CRACK LENGTHS, PLEASE SEE THE ANALYSIS MODULE
         HELP FILE.

     *****   RIGHT CORNER FASTENER   *****

     FASTENER LOAD =   19.28462 POUNDS (BASED ON 1000.0 PSI FAR FIELD REFERENCE STRESS)

     (A) CRACK GROWTH LIFE AND RESIDUAL STRENGTH:

         EDGE-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
            0.05000                0            44.00000
            0.20180             4522            44.00000
            0.27770             6584            44.00000
            0.35360             8409            44.00000
            0.42950            10010            44.00000
            0.50540            11411            44.00000
            0.58130            12625            44.00000
            0.65720            13628            44.00000
            0.73310            14367            44.00000
            0.80900            14782            44.00000

          TIP-TO-TIP       CRACK GROWTH        RESIDUAL
         CRACK LENGTH          LIFE            STRENGTH
           (INCHES)         (FLIGHTS)            (KSI)
         ------------      ------------      ------------
            1.19100            14782            44.00000
            1.93844            16803            44.00000
            1.97582            16885            44.00000
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            2.01506            16969            44.00000
            2.05626            17056            44.00000

.

. (etc…)

.
           22.45173            23406            28.91621
           23.26524            23422            26.06554
           23.49343            23426            25.34400

     (B) NDI INSPECTION INTERVAL:

         AFTER REPAIR INSTALLATION, FIRST INSPECTION IS AT    11713 FLTS.

          DETECTABLE           INSPECTION
         CRACK LENGTH           INTERVAL
           (INCHES)             (FLIGHTS)
         ------------          ----------
            0.05000              11713
            0.10000              10968
            0.15000              10223
            0.20000               9478
            0.25000               8797

.

. (etc…)

.
           18.73218                104
           18.78218                103
           18.83217                101

  NOTE:  FOR DEFINITION AND SKETCH OF THE DETECTABLE
         CRACK LENGTHS, PLEASE SEE THE ANALYSIS MODULE
         HELP FILE.

These results can be displayed graphically as Residual Strength vs. Crack Length, Crack
Length vs. Number of Flights, and Inspection Interval vs. Detectable Crack Length plots for
each side of the repair.  Each of these plots, which are shown below, is generated for longitudinal
cracks in the center and corner fasteners above the cutout and for circumferential cracks in the
center and corner fasteners to the right of the cutout.  The plots can be selected from the Damage
Tolerance section of the Analysis pull-down menu in the main RAPID MDI.
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8.2.5  View and Print the Report

To view the report, select Report from the Analysis menu.
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While the report is displayed, it may be printed by selecting Print  from the File menu.

This will invoke the Report Options dialog window, in which the user may choose which
components of the report to print.

8.2.6  Save the Repair Model

This completes the example problem. To save the model, select either the Save or Save As menu
item from the File pull down menu. Once saved, the model can be opened and modified in a
subsequent RAPID session by selecting the file open button on the button bar or the Open menu
item in the File pull-down menu.
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Appendix A.  Run Analysis From the DOS Prompt

The RAPID analysis programs are compiled FORTRAN programs:

Static Analysis - REPAIRS.EXE
Damage Tolerance - REPAIRD.EXE

Both programs read “initialization files” – these files contain the input, output, error, and
database filenames that are read by the analysis programs ( the following 2 filenames are hard-
coded into the program ) :

Static Analysis - REPAIRS.@#$
Damage Tolerance - REPAIRD.@#$

There is a 3 step process for running the analysis programs in the DOS mode:

1. Obtain the input data from the “saved” repair configuration file.
2. Modify the analysis initialization file.
3. Run the desired analysis program (the initialization file will be read by the analysis

program)

Obtain the Data

The Static Analysis input is stored in the [~STA_INP] section of the saved repair configuration.

1. Open the saved file using any ASCII text word processor
2. Search for [~STA_INP]
3. Block this section and copy it to the clipboard
4. Paste from the clipboard to your input file

Example of the start of the section:
:

;[~STA_INP]
REPAIR CONFIGURATION TYPE (1 External Doubler)
            3
SKIN/DAMAGE : Number of Layers

:

The Damage Tolerance Analysis input is stored in the [~DTA_INP] section of the saved repair
configuration.

Use the above procedure to cut and paste to your document.
Example of the start of the section:

:
;[~DTA_INP]
4

REPAIR CONFIGURATION TYPE (1 External Doubler)
            3
      SKIN: Mat. Type
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NOTE -- The input decks for both the static and damage tolerance files must NOT contain any
blank lines.

The binary stress spectrum files used by damage tolerance analysis can be found by searching for
the [~RPD_SP0] and  [~RPD_SP1] sections of the saved repair configuration.  The entries in
these sections give the files names of the stored data.

Example of the sections:
;[~RPD_SP0]
TYPE31._S0

;[~RPD_SP1]
TYPE31._S1

These file names are required for the initialization file described below.

Modify the Initialization File

STATIC Analysis

The static analysis program, REPAIRS.EXE, reads the initialization file, REPAIRS.@#$
File specification for REPAIRS.@#$

repairs.inp // input deck created by RAPID GUI
repairs.out // output deck created by REPAIRD.EXE
repairs.err // error file created by REPAIRD.EXE

These files can be named anything you wish, the program names them:

repairs.inp ~sta_inp.<#>
repairs.out ~sta_out.<#>
repairs.err ~sta_err.<#>

The extension, <#>, is an integer the program assigns when it opens a file or
starts a new file.

DAMAGE TOLERANCE Analysis

The damage tolerance analysis program, REPAIRD.EXE, reads the initialization file,
REPAIRD.@#$

File specification for REPAIRD.@#$

repaird.inp // input deck created by RAPID GUI
repaird.out // output deck created by REPAIRD.EXE
repaird.err // output deck created by REPAIRD.EXE
repaird.sif // *beta factors for baseline repairs
repaird.mat // *material database factors
repaird.fst // *skin stress factors for baseline repairs
1 // flag to indicate the next 2 files are the spectrum files to be used
repaird.sp0 // binary spectrum file(circumferential stress)created by
RAPID GUI
repaird.sp1 // binary spectrum file(longitudinal stress) created by
RAPID GUI
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1 // flag to indicate the next file is the proximity file to be used
repaird.prx // *fastener load transfer factors due to proximity effect
1 // flag to indicate the next file is the splice joint file to be used
repaird.jnt // *skin stress factors for splice joint repairs
1 // flag to indicate the next 3 files are the stiffener files to be used
repaird.stf // *skin stress factors due to stiffener effect
repaird.stb // *stiffener beta factors
repaird.lcf // *life correction factor database for splice joints
1 // flag to indicate the next file is the circular file to be used
repaird.cir // *circular repair ratio factors

Note: 0=Do not read filename on next line; 1=read filename on next line.
* Do not change these file names

User may execute analysis with either proximity effect, stiffener effect, or splice joint.
These effects cannot be combined yet.  So only one of the flags may be set to 1.

The following files can be named anything you wish, the program names them:
repaird.inp ~dta_inp.<#>
repaird.out ~dta_out.<#>
repaird.err ~dta_err.<#>
repaird.sp0 ~rpd_sp0.<#> // binary spectrum file - circumferential
stress
repaird.sp1 ~rpd_sp1.<#> // binary spectrum file - longitudinal stress

The extension, <#>, is an integer the program assigns when it opens a file or
starts a new file.
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Appendix B.  Save Output Data to be Used by Other Programs

The static analysis output is stored in the [~STA_OUT] section of the saved repair configuration.

1. Open the saved file using any ASCII text word processor
2. Search for [~STA_OUT]
3. Block this section, and copy it to the clipboard
4. Paste from the clipboard to your document

Example of the start of the section:

:
:
:

;[~STA_OUT]

                        STATIC ANALYSIS RESULTS OF THE REPAIR
                        -------------------------------------

 (A) MARGINS OF SAFETY:
:
:
:

The damage tolerance analysis output is stored in the [~DTA_OUT] section of the saved repair
configuration.

Use the above procedure to cut and paste to you document.
Example of the start of the section:

:
:
:

;[~DTA_OUT]

               DAMAGE TOLERANCE ANALYSIS RESULTS OF THE REPAIR
               -----------------------------------------------

      THE FOLLOWING 2 SETS OF OUTPUT ARE FOR THE CIRCUMFERENTIAL CRACKS:
:
:
:
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Appendix C.  Description of RAPID.INI File

The RAPID.INI file is used to provide initialization and default data for the application.

It is structured like a generic Windows’ INI file.  The text within the brackets [..] is called the
“section” and the text under each “section” are called “entries.”  RAPID accesses and updates
this file through the Tools | Setup menu.  RAPID is shipped without this INI file.  With the initial
run of RAPID, an INI file is constructed with hard-coded data and file location entries on the
current drive/directory.

The section/entry names must not be changed!!!

[Version]
Number=2.0

[File_Locations]
Prog_Dir=D:\RAPID2C
Data_Dir=D:\RAPID2C
Temp_Dir=D:\RAPID2C
Loads_Dir=D:\RAPID2C\LOADS

[RepairType]
Type=TYPE30
ProximityFlag=0 // 0-false 1-true
StiffenerFlag=0 // 0-false 1-true
LapReversedFlag=0 // 0-false 1-true

[Report_Options] // parts to be printed on the report
Static_Input=0 // 0-false 1-true
Static_Results=1 // 0-false 1-true
DTA_Input=1 // 0-false 1-true
DTA_Results=0 // 0-false 1-true
Residual_Plot=0 // 0-false 1-true
Flights_Plot=0 // 0-false 1-true
Inspection_Plot=0 // 0-false 1-true
Analysis_Notes=0 // 0-false 1-true

[Fastener_Data]
Long_Pitch=1.0
Circum_Pitch=1.0
Long_Edge=0.5
Circum_Edge=0.5
Style=NAS1097-E
Diameter=0.1875
Rows=3

[DTA_Options]
Run_Type=2
Crack_Growth=1
Hole_Options=1
Visual_Method=0 // 0-false 1-true
Retardation=0 // 0-false 1-true
PrimaryTip=0.05
SecondaryTip=0.0
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OperatingPressure=

[Stress_Data]
EquivStress=1 // 1-RAPID calculated with RAPID data

// 2- User entered value
// 3- RAPID calculated with User data

EquivStressValue= // Equivalent Stress value
SpectrumUsed=3 // 1-RAPID defined 2-User defined (binary)

// 3-User defined (ascii)
SpectrumName=Generic Narrow Body
InputFormat=1 // 1-Pseudo-Flights (repeatable flight sequence)

// 2-Cycle-by-Cycle Stresses (repeatable block)
RainFlow=0 // 0-false 1-true
Truncation=0 // 0-false 1-true
TruncRange=2.0
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Appendix D.  Description of Stiffener Effects Regions

Damage Tolerance Input File

.

.

.

.

.
STIFF   : MAX #, POS, CSA, YNG.MOD, HPIT

0 0.0 0.0 0.0 0.0
1 1.5 0.5 10500 0.909
0 0.0 0.0 0.0 0.0
0 0.0 0.0 0.0 0.0
1 26.5 0.5 10500 0.909
0 0.0 0.0 0.0 0.0
.
.
.

CL

Region 0 Region 1 Region 2 Region 3 Region 4 Region 5

Fastener
#1 Fastener

#27

1.5” 26.5

Regions -Each repair has 6 regions numbered from left to right:

Region 0: Outside left (repair boundary) of the repair to the left most side of the repair
(absolute distance)

Region I: Left most side of the repair to the left most side of the cutout

Region II: Left most side of the cutout to the center line of the repair

Region III: Center line of the repair to the right most side of the cutout

Region IV: Right most side of the cutout to the right most side of the repair

Region V: Outside right (repair boundary) of the repair to the right most side of the repair
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Stiffener Input Line fields:

MAX # Number of stiffeners in region;  maximum of 8 stiffeners per region

POS Absolute position of the stiffeners in relation to the whole repair (from the left edge of the
repair); for:

REGIONS 1-4, 0.0 ≤ POS ≤ Max.DoublerSize;
REGION 0, POS is the absolute distance of the stiffener away from the left edge of the
repair;
REGION 5, POS is the absolute distance of the stiffener away from the right edge of the
repair.

CSA Cross-sectional area of the stiffener

YNG.MOD Young’s modulus of the stiffener

HPIT Pitch of the fasteners in the stiffener

DBLR ID - If more than 1 repair doubler, indicate which repair doubler is being used in
referencing the stiffener’s positions, 1=first doubler and 2= second doubler.  If there is only 1
repair doubler, then DBLR ID=1.

Note: Each stiffener in a region has a position, cross-sectional area, Young’s modulus, and
fastener pitch in the stiffener parameters associated with it.

Although there might not be any stiffeners in the repair or region, enter 0 (or 0.0) in the number
of stiffeners, position, cross-sectional area, Young’s modulus and pitch parameters.
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